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C H A P T E R  1  

Forward Work Programming in RAMM was originally funded by the New 

Zealand Transport Agency (NZTA). This guide has been reproduced with their 

kind permission. 

This guide is specifically intended to help you use and understand the functions of 

the Forward Work Programme module in the RAMM software from RAMM 

Software Limited. 

You may also need to refer the Using RAMM guide. If you are not sure whether 

you are reading the right guide, see RAMM Guides and Manuals (on page 23). 

This section tells you how to get the most out of using the rest of the document. If 

you are familiar with Forward Work Planning you can use the links to go directly 

to the section you need. If you are new to Forward Work Planning, it is 

recommended that you read the entire guide. 

 

About This Guide 





 

  

C H A P T E R  2  

The New Zealand Transport Agency (NZTA) retains control of their RAMM 

master databases. They provide, to their Users, access to portions of the database 

that are categorised by Security Zones, referred to by NZTA as Network 

Management Areas. 

Your use of the RAMM Forward Work Programme and its facilities varies, 

depending on whether you are at NZTA and wish to work within this region, or 

you are a Consultant and wish to work with a Network Management Area. 

For this reason throughout this document we refer to Nationally and Locally 

controlled information. Nationally controlled data and functionality means that it 

is available to NZTA. Locally controlled data and functionality is available to the 

Consultant. 

The type of access you have to the Forward Work Programme is determined by a 

flag, held within your security profile, that tells the RAMM Forward Work 

Programme whether you are working as a Road Controlling Authority (RCA) or a 

Consultant. 

If you are using the RAMM Forward Work Programme in a Local Authority 

situation you have two choices. Firstly, you can operate in a similar fashion to 

NZTA, working with the RCA and Consultant functions. Alternatively you can 

operate with a single version of the RAMM Forward Work Programme which is 

for a Local Authority and which allows access to both the RCA and Consultant 

data and functions. This is achieved by setting the flag in your security profile to 

Local Authority. Local Authority users can access all the functions described. 

While using this document, please keep in mind the type of environment you're 

working in. 

 

Introduction 
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Road Assessment and Maintenance Management ( ) is software developed 

and supported by RAMM Software Limited. This software is used by Road Controlling 

Authorities (RCAs) to manage Road Inventory Assets and Condition for their 

Network. 

 is the complete package for Asset maintenance, valuation, assessment, 

Forward Work Planning as well as inventory-based Asset management. It also 

includes a range of report and analysis applications which complement the 

management functions. 
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What is RAMM? 

The  (Road Assessment and Maintenance Management) software from 

RAMM Software Limited is a comprehensive suite of applications to maintain and 

manage Road Inventory and Condition data. 

 

 

The name  is used not only for a suite of Road Assessment 

and Maintenance Management applications but also for the central 

software application itself. 

 

The RAMM Suite 

The full  suite includes  (sometimes referred to as  for 

Windows), , , , 

, , ,  

and .  

When  was introduced to the industry in the 1980s, it was a green screen 

application. Later a GUI (graphical user interface) was introduced. This is when it 

was sometimes called  for Windows. As users came to expect more from 

 other applications were added. , 

 and  were added to facilitate Lookup, Staff Permissions, 

process, report and Network maintenance, database manipulation and data 

extraction. When Network Owners and Contractors needed a better system for 

contract management,  and  were introduced. 

Recently the  has been added to enable NZ Corridor Managers to 

manage access to their Network.  has been designed to 

give clients greater control over the users who access their Network data. It will be 

rolled out to our New Zealand clients in the near future.  enables easy 

viewing of  data on a map without having to log in to . 
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Your RAMM Applications 

The full  suite includes the following applications. You can access each 

individual application only if you have the correct Staff Permissions. 

 RAMM (for Windows) 

 (for Windows) is the central application of the  suite. You access 

your Inventory, Asset and Condition data for your Network from . 

 RAMM Manager 

 is the module in the  suite of products which you use to 

set up Lookups, to maintain Staff Permissions, to run processes such as Status 

Check, and to run reports. 

 RAMM Contractor 

 is the module of the  suite of products which enables 

Contractors, Network Owners and Consultants to manage Road Asset 

Maintenance Contracts. In particular, it has been optimised to facilitate the 

Programming of Network maintenance and the Estimation and Claims process 

which is integral to Programmed Maintenance Contracts. It also includes the 

special features for the managing of Contracts for Signs, Street Lights and Traffic 

Signals maintenance. 

 Pocket RAMM 

 is the module of the  suite of products which enables a 

user to run  on a netbook, laptop, tablet or PDA, and to perform Contract, 

Inventory and Claim management while mobile, in the field. Virtually all of the 

everyday maintenance ability of  is present in . 

Please note that the  application has become so comprehensive that 

the use of PDAs with  is no longer recommended. PDAs are no 

longer powerful enough to deliver a positive user experience. 

 RAMM SQL  

 is the module of the  suite of products which enables a power 

user to manipulate  data using SQL (Structured Query Language). It is a 

very powerful tool and should be used only by advanced users who have a detailed 

knowledge of the  database. 
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 RAMM Network Manager  

 is the module in the  suite of products which 

you use to manage the details of your Network and in particular, the Road centre 

lines.  is a powerful, flexible and comprehensive Road 

Network maintenance tool that helps you automate tasks and perform complex 

Network management actions. For example, you can reverse a Road with a single 

press of your mouse. When you apply this change  

will update all relevant tables within the database. It also has a graphical display 

which displays current and historical views of the changes you are making. 

 Hosting Administration 

The  is an online application which enables users to 

manage access to their Network. It enables Network Administrators to create 

logins for individual users and allows those individuals to maintain their own 

passwords. At the time of writing, Hosting Administration is available only to 

Western Australian LGAs who are clients of <arrb>. 

 CAR Manager 

 is the online application used by corridor managers to manage 

requests by utility operators, or their contractors, to access the Road corridor. 

Access to the corridor is required to make changes to electricity, gas, 

telecommunications, water, wastewater and postal infrastructure. At the time of 

writing,  is available only to New Zealand RCAs who are clients of 

RAMM Software Limited. 
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 RAMM GIS 

 is the  Geospatial Information Service. Using it is a bit like 

flying over your network and viewing your  data, but without ever leaving 

the office. 

 

 

Your ability to view and access the complete suite of  

products will depend on your Staff Permissions. Best practice is to 

grant you permission to view and access only those applications 

which you need for your normal duties. 

 

 

Your RAMM Database 

All your Road Inventory and Condition information in  is stored in a 

central database. Everything you do in  is linked to it. All the actions you 

perform affect it. 

How the Database Is Arranged 

The information in the  database is stored in tables. There are many of 

these, one for each aspect of the Road Network. Examples of  tables are 

Surface Structure and Roughness.  often combines information from 

different tables when you are working with it. 

Each table holds its data in a combination of rows and columns. Each row in a 

table can also be called a record. It contains all the details for the particular aspect 

of the Road section - for example, the Start Displacement, Material, Construction Date 

and so on of a particular Road section. Each individual item of data is held in its 

own column. 

These columns are related to the fields on  screens. Information in a field 

on a  screen resides in a table column. The column contains information 

about all the Roads, but pertaining only to one aspect of the Road - for example, 

just the Displacements for the various Roads and Road sections you are looking at. 
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Road Asset:  Column (Field):    

Surface 

Structure 

Table 

Road Name Start 

Displacement 

Pavement Type Construction 

Date 

Row (Record): Smith Street 000m Thin Surfaced 

Flexible 

17/03/2003 

 
Jones Road 100m Concrete 12/02/2000 

 

 

 

You will see messages and warnings from time to time, some 

accompanied by detailed, database related information. It is always useful 

to either print or record this information somewhere and have it at hand 

when you call RAMM Software Limited for assistance. See Contact RAMM 

Software Limited (on page 26). 

 

 

 

Your Other Software and RAMM 

When you are working with , you will use other software. The following 

list is not exhaustive. Also, you might not use some of the software listed. 

Internet Browser 

Your web or internet browser is the software application you use for accessing, 

presenting, and navigating information on the World Wide Web. You use it to 

access  through the  Hosting Service. Common browsers are Internet 

Explorer, Firefox, Safari and Chrome. Best results for accessing  through 

the  Hosting Service have been achieved using Internet Explorer. 

Citrix Client 

The Citrix client is a third party, remote access application. It allows users to 

access  remotely. It enables secure passing of data between a remote server 

and your local, or client pc or other device. Once the Citrix connection is 

established, you work with  as if it were running on your local device. 
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Microsoft Excel and Others 

You can export  data in a format usable in Microsoft Excel, Access and 

other data manipulation and reporting software. 

Windows Explorer 

You use Windows Explorer (sometimes referred to as My Computer) to access 

files on your computer which you attach to records in  on the Multimedia tab 

of the  Detail screens. Similarly you can use the software to download and 

save  multimedia files to your own hard drive. 

dTIMS 

Deighton Total Infrastructure Management System (dTIMS) is a software tool 

used to model Pavement Deterioration.  provides a method of extracting 

Treatment Length, Maintenance Cost and related data from the Road Network in 

a format that can be imported into dTIMS.  You export information from  

for use in dTIMS, and then import the results of your analysis back into . 

RAMM Web Service 

A web service is software application supporting one software product to talk to 

another. You use the  Web service to enable your CSRs (Customer Service 

Representatives) to use their customer service software to add a Job into 

 for, say, a Street Light out, and to monitor the Job progress. 

Configuring access to the  Web Service is the responsibility of 

the Network Owner. 

 

The RAMM Main Screen 

The  main screen is your portal to your  database. You should 

familiarise yourself with its main items. 
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No Item Comments 

 

Menu Bar This contains the standard drop-down lists with 

which all Windows users will be familiar.  

 

Tool bar This is a repository for shortcuts to the screens you 

use most often. 

 

Show toolbar menu (screen 

selection drop-down list) 

You press this button for the drop-down list to access 

all the  Inventory, Condition and other data 

screens. 

 

Roads list panel This panel lists all the Roads in your Network. You 

can Filter this list to include only the group of Roads 

you require. 

 

Expanded tree You press  to expand the tree and reveal the 

Carriageway Sections for a Road. 
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Detail screen Detail screens display the details for one  

Inventory, Condition or other data record. You edit 

the item details at the Detail screen. 

 

Grid screen Grid screens display the details for one or more 

 Inventory, Condition or other data records. 

You use Grid screens for reporting and other 

purposes. 

 

Map 
The Map in  is a wonderful tool for 

visualising your Network and updating it. 

 

Status bar This is where you look to see useful information 

about what you are doing. 

 

 

RAMM Terminology 

In , as with any software application, there are terms which have a meaning 

specific to the software. When you are working in  you will encounter 

these terms. You should have an understanding of them before you do. Some of 

these terms are also used in the wider Road industry. The definitions below are 

specific to .  

The following list is a minimum of the terms you need to understand before you 

start to work with . You can also look at the Glossary at the end of this 

guide for a more comprehensive list. 

RCA 

A Road Controlling Authority (RCA) is the organisation responsible for a 

particular Road Network. An example of an RCA could be the New Zealand 

Transport Agency (NZTA) or a TLA (Territorial Local Authority). 

Network 

A Network is a collection of Roads managed by a particular Road Controlling 

Authority (RCA). Each  database usually contains all the information for 

one Network. 
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Road 

For Local Authorities, a Road denotes a single named Road that is part of their 

Network. For State Highways, a Road is a segment of the State Highway. Roads 

may include associated Assets such as Pavement, Top Surface, and Shoulders. 

Assets such as Signs and Surface Water Channels are associated with a Road. 

Carriageway 

Roads in  are divided into logical sections named Carriageways. These start 

and end at easily identifiable Locations such as Intersections and Bridges. You can 

define your Carriageway Sections to suit your own purposes. For instance you 

may define them to start and end when the number of Lanes in the Road changes 

or if the Road changes between Sealed and Unsealed sections. A Carriageway 

Section starts at one Displacement along the Road and ends at another 

Displacement. Carriageways define the lengths of Road against which other Assets 

can be referenced. 

Displacement 

Displacement is the distance along a Road measured from the start of the first 

Carriageway Section of the Road. It is stated in metres. 

Location 

Location refers to the collection of details used to position an Asset or Inventory 

item within a database. The most basic Location information is a combination of 

Road and Displacement. Location information can also include helpful notes such 

as nearby landmarks. Point Assets such as Signs have a Location field whose value is 

the Displacement of the Sign from the start of the Road. 

Asset 

An Asset is an item in a Network which has a value. It could be a physical 

component of a Road, such as its Surface. It could be something real such as a 

Bridge, a Footpath or a Street Light. Where no table exists in  for one of 

your Asset Types, you set up a User Defined Table (UDT) to manage the Assets. 

Nonasset 

Nonassets are items for which screens exist in  but which have no 

monetary value. They are generally something not physically present on the Road 

Network such as Roughness, Maintenance Cost and Crash. You can set up User 

Defined Tables (UDTs) to manage Nonassets which do not have their own 

screens in . Examples could be slips, hazards and certain Condition data.  
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Stock Asset 

In  the three Asset Types, Signs, Street Lights and Traffic Signals are 

referred to as Stock Asset Types. This is because, unlike the other Asset Types, 

when Signs, Street Lights and Traffic Signals Assets or components are replaced, a 

detailed record is kept of the replacements including the Replacement Reason. So 

you have an itemised list of the current and past Assets. You create Stock UDTs to 

manage those of your Assets (if any) which do not already exist in  and for 

which you need to keep replacement records. 

Network Inventory 

Your Network Inventory is your  database records including real items 

such as a Bridges and Footpaths as well as your Survey and other data such as 

Crashes and Bylaws. Your Condition data such as Roughness and your report data 

such as  3D do not form part of your Network Inventory. 

Condition 

The term Condition has two related meanings in . In  Assessment 

the Condition of an Asset describes its fitness or readiness for use. Typical  

and NAMS Conditions are Excellent, Good, Average, Poor and Very Poor. Assessment 

Condition Weighting is used to determine Risk of Failure and the Consequences 

of Failure. 

There are also Road Conditions which have their own  screens. 

Roughness, High Speed Rutting and Skid Resistance are examples of  items 

used to describe the Condition of your Roads. 

You will be able to tell from the context in which it is used, which meaning of the 

term Condition is intended. 

Assessment 

An Assessment is the record of an inspection of an Asset. You use Assessments for 

a number of reasons including to record the Condition of an Asset or its associated 

Likelihood and Consequences of Failure (Risks). Rating and HSD are used to 

Assess Roads. 

Rating 

Rating is the process of recording the state of a Road by measuring the extent of 

the deterioration which has occurred. This includes factors such as the length of 

Cracking and Potholes. This is sometimes referred to as Condition Rating. 
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HSD 

High Speed Data (HSD) is the collective name for particular properties and state 

of a Road as measured by specialised equipment mounted on a vehicle. The 

properties of the Road include its slope and curvature values. The state of the 

Road includes its Roughness and Skid Resistance values. 

Treatment Length 

A Treatment Length is a section of a Road with consistent performance and 

purpose. For example, it could have the same Top Surface material and Annual 

Average Daily Traffic (AADT) count along its length. A Treatment Length may 

have had similar Treatments applied along its length and is often different from its 

adjoining sections. 

Treatment Lengths may coincide with Carriageway sections, but the same 

Carriageway section may have more than one Treatment Length. A Treatment 

Length may span more than one Carriageway section. Treatment Lengths will 

usually change over time, as conditions change. 

Treatment Selection 

A Treatment Selection is a recommended treatment for a Treatment Length to be 

carried out in the next twelve months. This recommendation can of course be No 

Treatment. Treatment Selections are generated in  using the Treatment 

Selection Algorithm (TSA). 

 

Log in to RAMM 

You must log in to  before you can use it. 

You cannot log in to any of the  applications unless you have a login name 

and a password. Once you have logged in you need appropriate Staff Permissions 

to carry out tasks related to your role. 

Contact the Systems Administrator for the correct Staff Permissions to perform 

your normal tasks. See the Security chapter of the Working with RAMM guide. 

You log in to  using the  Hosting Service. 
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RAMM Hosting Service 

The  Hosting Service is a service run by RAMM Software Limited. It enables you 

to run  across the Internet. It hosts your database and the software on a 

server at a centralised location. You use your standard internet browser to access 

the software and work with your data, so you do not need any specialised software. 

It is very secure. 

You use the  Hosting Service from anywhere with an internet connection. 

The graphic below shows the the options to access  using the  

Hosting Service. 

 

 

 

Logging in to the RAMM Hosting Service 

Introduction 

You log in to the  Hosting Service to access the  applications.  

Before you do this you need to have: 

• been granted access with a username and password by RAMM Software Limited. To 

contact RAMM Software Limited for assistance, see Contact RAMM Software Limited (on 

page 26). 
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• Downloaded the MetaFrame Presentation Server Client for 32-bit Windows. You do 

this by clicking the link on the RAMM Software Limited website Log in page and 

following the instructions. 

• opened your web browser such as Internet Explorer or Mozilla Firefox. 

Menu Path 

Follow the menu path ramm.co.nz https://login.ramm.co.nz/ to open the Log in page. 

►  To  Log  in  to  t h e  RAMM Hos t ing  Serv ice  

 

 

To do this you follow these steps: 

1 Type your username and password in the User name: and Password: fields. 

2 Press Log In. 

The Applications panel will open. What you see in the Applications panel will depend on 

your Security Permissions. 

 

 

3 Do you want to use ? 
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Yes go to step 4. 

No go to step 6. 

4 Press the Pocket Applications icon. 

The  applications will become available. 

5 Go to step 7. 

6 Press RAMM 2011. 

The Applications panel will open. The software icons will be available. 

 

 

7 Press the icon for the  software you want to use. 

The  software application will open. If you have access to more than one 

database, a dialog will open so that you can choose the database which you require. 

 

 

If you use an older version of Mozilla Firefox as your internet 

browser, a Warning telling you that you do not have the MetaFrame 

Presentation Server Client for 32-bit Windows will display as in 

the Log in page screen shot above. Once you have downloaded the 

software you can ignore this warning. 

 

 

RAMM Help Options 

The time will come when you will want to know more about  so that you 

can be both more proficient and efficient. Use the following options to upskill: 

• use the Help from within the software. See Context-sensitive Help (on page 20). 

• use internet-based Help. See  Help on the Internet (on page 22). 

• read the  documentation. See  Guides and Manuals (on page 23). 

• discover the  tables and columns. See Database Details (on page 25). 

• talk to other  users. See Help from Other Users (on page 24). 

• seek professional help. See Contact RAMM Software Limited (on page 26). 
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Context-sensitive Help 

User assistance has been integrated into the  applications. 

Most screens in  have a Help  menu option. You press F1 on your 

keyboard or press Help  at the top of the screen to open the context-sensitive 

Help. 

As you can see in the graphic below, when you press Help  at the top of the 

screen, one page in a .chm file will open. In this example information to enable 

you to view Scheduled Traffic Counts on the Map on  is being offered. 

If the information on the page does not solve your issues, you can navigate 

through the .chm file. Use the Search and Index to speedily locate the information 

you require. 



 

 C h a p t e r  3   –   I n t r o d u c t i o n  t o  R A M M  2 1   

 

 

If you still need further information you can follow the menu path Help > Website > 

Read Latest Manuals. This will take you to a list of the latest  manuals and 

guides where you can search for answers. 
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RAMM Help on the Internet 

The  user guides and manuals are available from the RAMM Software Limited 

web site (http://www.ramm.co.nz). They are generally available in both 

downloadable .pdf versions and in online Web Help versions. 

 

 

Web Help 

The Web Help versions of the user guides and manuals are the primary versions 

you will want to use. They are available from the web site and so are available to 

you, so long as you have access to the internet. 

The Web Help versions open in your internet browser and are very attractive. 

They are fully searchable. They have both a table of contents and an index for 

quick access to the information you want. 

Their only disadvantages are that you can print only one page at a time and they 

are not available to you when the internet is not available. 

PDFs 

The .pdf versions of the user guides and manuals are useful mainly if you want to 

print complete documents or large portions of them. 

Also, the .pdfs may be useful if you want to keep your own copy of the manual on 

your desktop or mobile device. 

Google Search 

If you type a question into the Google search, this will sometimes return the 

information you are after. This can be hit or miss. 

 

http://www.ramm.co.nz/
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RAMM Guides and Manuals 

RAMM Software Limited offers useful guides and manuals to enable you to maximise 

the benefits to you of using . 

Release Notes 

Users who want to know what is in the latest version of  should read: 

• What's New in RAMM 2011 (Web Help) 

This is a detailed description of the changes and improvements to the  software 

suite in the 2011 release. In particular, it is the changes to Assets, Data, Finance, 

Patrols, Reports, Roads and Traffic Count Estimation, which are featured. The Web Help 

version of this document is fully detailed and fully searchable. 

Basic Help 

Users who are new to  need to understand the  basics to maximise 

their experience with the software. They should read the following  primer 

as it includes very helpful introductory information: 

• Using RAMM 

This is a basic help guide introduction to . It covers the essentials, common 

tasks, procedures as well as Mapping and Decision Cube functions. There is a 

comprehensive explanation of the  tool bar controls. 

Advanced RAMM Functions 

Users familiar with  and ready for its more advanced functions should read: 

• Best Practice for Assessment in Pocket RAMM 

This guide shows how you can set up Assessments for  and record 

your Assessments in the field. This guide is available online only. 

• Managing RAMM 

This advanced guide includes sections on Skid Resistance, Treatment Selection and 

Auditing Survey data. It has not been updated recently. This guide is available online 

only. 

• RAMM Assessment 

This guide is for those who manage and record Assessment Inspections of Network 

Assets, enter the results into  and generate analyses of Condition and Risk. 

• RAMM Asset Valuation 

This advanced guide to the Asset Valuation process covers valuing a Road Network and 

calculating Replacement Costs. 

• RAMM Forward Work Programme 

This guide is for those who use  Forward Work Programme (FWP) - also 

known as NOMAD. It is an advanced tool for forecasting and analysis. 
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• Traffic Count Estimation 

This guide explains the set up and use of the  Traffic Count Estimation 

System. 

• Working with RAMM 

This is an advanced help guide for power users of . Use this guide only if you 

have a good working knowledge of , its Assets, the database structure and key 

components such as Treatment Lengths. This guide covers: User Defined Assets, 

Surfaces, , Bridges, Maintenance Activity, Pavement Structure, Pavement 

Strength and  Security. 

RAMM Contractor Guides 

Those users who need to know how to use  should read the 

following manuals: 

• RAMM Best Practice 

This guide gives step-by-step instructions on how to run a Programmed Maintenance 

Contract in . It is available as a .pdf or .xhtml file but not as a 

printed manual. 

• RAMM Contractor 

This guide is for those Road Maintenance Contractors and Network Owners who use 

 software. It covers setting up Contracts, managing Dispatches, 

generating Claims for work done and reporting on Contract activities. 

Printed Manuals 

RAMM Software Limited is happy to provide you with printed manuals to which you 

can refer at your convenience. 

There is a small charge for additional copies of the manuals. Printed manuals do 

not require access to a computer or the Internet and are ideal for browsing, 

reference or learning about something in depth. 

There are a number of guides which are available to  users. The following 

list includes those most used and gives a brief overview of what they cover. For a 

full list of available guides, see the RAMM Software Limited web site Documentation 

page (http://www.cjntech.co.nz/index.php?section=55). 

 

Help from Other Users 

Other users can be a mine of information. 

If there are other users in your organisation, you should approach them if they 

perform the same tasks as you do or if they have been using  for longer 

than you. 

http://www.cjntech.co.nz/index.php?section=55
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They probably know shortcuts, tips and tricks which they can teach you. Don't 

reinvent the wheel. Talk to someone who knows more than you. 

 

 

 

RAMM Database Details 

When you begin to carry out more complex tasks, you will need to know where 

specific details are stored in the  database. These details are available in the 

Database Structure report. 

The Database Structure report is a listing of all tables and columns in the  

database. It is available from the  main menu. You follow the 

menu path Reports > Database Structure.  



 

2 6  F o r w a r d  W o r k  P r o g r a m m e  
 

You then choose the tables you wish to view and then press Preview or Print to view 

or print the report. 

 

 

 

Contact RAMM Software Limited 

Internet 

This is the link to open the RAMM Software Limited web site 

(http://www.ramm.co.nz). 

Email 

This is the link to send an email to  Support 

(mailto:support@ramm.co.nz). 

This is the link to send an email to  Documentation 

(mailto:documentation@ramm.co.nz). 

Phone 

+ 64 9 475 0500 

0800 256 832 from within New Zealand only 

1800 196 213 from within Australia only 

http://www.ramm.co.nz/
mailto:support@ramm.co.nz
mailto:documentation@ramm.co.nz
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Fax 

+ 64 9 475 0501 

Postal Address 

PO Box 302 278 

North Harbour 

Auckland 0751 

New Zealand 

Physical Address 

102 Rosedale Road 

Albany 

Auckland 

New Zealand 

 

Comments and Suggestions 

If you have any feedback about this document or about the software itself, please 

contact RAMM Software Limited at whichever address above is convenient to you. 

Your observations and suggestions are welcome. Your feedback is an important 

element in improving and updating the  experience. 
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Background 

This guide is an introduction to the RAMM Forward Work Planning tool and is 

written from the perspective of the New Zealand Transport Agency (NZTA) and 

their Consultants. See The NZTA Web Site (see Transit New Zealand - 

http://www.transit.govt.nz). 

The RAMM Forward Work Programme is designed to store pavement treatment 

information at project level for a period of up to 20 years. 

For example, you could plan to carry out a grade 3/5 two coat reseal on SH 3 RS 

269 RP 0.100 - 2.540 in six years time. 

 

Theory 

This document is to be used in conjunction with the State Highway Asset 

Management Manual (SHAMM, SM020). The SHAMM contains the New 

Zealand Transport Agency (NZTA)'s philosophies and expectations for the 

management of State Highway Assets. 

The manual is also available online 

(http://www.transit.govt.nz/technical/view_manual.jsp?content_type=manual&=e

dit&primary_key=18&action=edit) at the NZTA website in Adobe Acrobat PDF 

format. 

 

Objective 

The primary purpose of this document is to help Asset Engineers use the RAMM 

Forward Work Planning software to meet the expectations of the New Zealand 

Transport Agency (NZTA) as described in the SHAMM. 

However Road Controlling Authorities will also find Forward Work Planning 

useful for effective road asset management. 

 

Security Zones 

It is appropriate to have a short discussion on Security Zones and in particular, 

what they look like and how they are used. 

http://www.transit.govt.nz/
http://www.transit.govt.nz/technical/view_manual.jsp?content_type=manual&=edit&primary_key=18&action=edit
http://www.transit.govt.nz/technical/view_manual.jsp?content_type=manual&=edit&primary_key=18&action=edit


 

 C h a p t e r  4   –   O v e r v i e w  3 1   

At its most fundamental level, a Security Zone is a way of  naming a list of roads 

from your network. For example, you might create a list of roads from the State 

Highway network and call it East Waikato Network Management Area. 

Of course there is more to it than that. Starting from the RAMM 2008 Release, 

Security rules for accessing the database are based on the Security Zone. You may 

have access to one or more Security Zones in the database. You choose which one 

you want to access and you will be given the permissions assigned to you for that 

Security Zone. 

 

 

The above diagram is a stylised network being the area enclosed in the outer box. 

This outer box is considered to be a special Security Zone named the Entire 

Network. The Entire Network has some special characteristics such as it must 

contain every Road in the database at all times. You will come across other cases 

where the Entire Network is special as you read through this document. 
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As you can see in the graphic, the Entire Network has been divided into three 

mutually exclusive Security Zones named A, B and C. All Security Zones in 

RAMM must have a parent Security Zone with the exception of the Entire 

Network. When you are selecting Roads for your security Zone, you can only 

select those from the parent Security Zone. In the example above, the Security 

Zones A, B and C have the entire network as their parent. They have been defined 

as being entirely separate from each other. That is there are no Roads in Security 

Zone A which are also in B or C. 

Since Security Zones A, B and C are mutually exclusive, a user who logs in to 

Security Zone A can only see asset and condition information from their own 

Roads. Information on Roads in Security Zones B and C is not available to this 

user. 

When creating Security Zone D, its parent was defined as being Security Zone C. 

This means that the Roads associated with Security Zone D are a subset of those 

in Security Zone C. In this case, both Security Zones C and D can see the same 

asset and condition information, but only for those Roads that they have in 

common. Security Zone C has more Roads and therefore more information 

available to it. Users of Security Zones A and B can not see information associated 

with Security Zone C or its child D. 

Security Zone E is a bit different. Its parent is the Entire Network and it has Roads 

within it which are also in Security Zones B and C. Therefore when you log in to 

Security Zone E you will see some asset and condition information that users of 

Security Zone B can see and some information that users of Security Zone C can 

see. However, you will not see all the information that users of either Security 

Zones B and C can see. 

Summary 

You can create mutually exclusive Security Zones in which users of one can not 

see asset and Roading information of the other. In a State highway situation, such 

Security Zones may correspond to the Network Management Areas. 

A Security Zone may be the parent of one or more child Security Zones. In the 

context of the State Highway RAMM database, these might be Network 

Management Contract Areas within the Network Management Areas. 

It is also possible to define Security Zones which have roads in common. When 

this occurs, users of both of these Security Zones can see the information 

associated with Roads they have in common but can not see information for Roads 

not in their own Security Zone. 
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Overview Process 

Below is an overview of the process for development of a robust Forward Work 

Programme (FWP): 

1 Read SHAMM 

2 Manage Treatment Lengths 

3 Update Treatments 

4 Update Maintenance Intervention Strategy (MIS) codes 

5 Perform FWP Analysis and Reporting 

6 Review steps 1 to 5 as necessary. 

 

Lookup Codes 

In addition to the above, the Forward Work Programme also requires the 

management and maintenance of several lookup codes, these being: 

• Funding Groups 

• Treatment Groups 

• Cost Sets 

• Reasons 

• Primary Motivators 

• Maintenance Intervention Strategies (MIS) Codes 

• Safety Intervention Strategies (SIS) Codes. 

As with all software applications, it is essential for these lookup codes to be initially 

populated to various degrees before preparing a Forward Work Programme. 

 

High Level Processes 

This document also describes a number of processes that will not involve the Asset 

Engineer but will nevertheless be useful. 

• Unloading and Loading the Forward Work Programme 

• Maintenance Allocation Review Group (MARG) Priority Calculation 

• End of Year Rollovers 

 





 

  

C H A P T E R  5  

This chapter is a brief overview to assist in the understanding of Forward Work 

Planning. 

A more detailed discussion of Forward Work Planning and the processes you 

should follow both within and external to its implementation in RAMM can be 

found elsewhere.  

Please see SHAMM 

(http://www.transit.govt.nz/technical/view_manual.jsp?content_type=manual&=e

dit&primary_key=18&action=edit). 

In  Th is  Chap ter  

Philosophy of Pavement Maintenance Management ................. 36 

Business Systems Process Overview ........................................... 36 

Information Requirements ......................................................... 36 

The Intellectual Process .............................................................. 37 

 

 

 

Understanding Forward Work Planning 

http://www.transit.govt.nz/technical/view_manual.jsp?content_type=manual&=edit&primary_key=18&action=edit
http://www.transit.govt.nz/technical/view_manual.jsp?content_type=manual&=edit&primary_key=18&action=edit
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Philosophy of Pavement Maintenance Management 

The New Zealand Transport Agency (NZTA)  allocates a percentage of its annual 

budget for general maintenance, reseal and pavement reconstruction works. This 

is required to maintain an acceptable level of service and to counter the normal 

deterioration rate. 

The amount of expenditure on maintenance works is significant and any small 

improvement in the way the network is maintained, without detriment to the long 

term integrity of the pavement, can lead to significant cost savings. 

Please see Chapter 1 - Section 1 of the SHAMM for a detailed discussion of the 

philosophy of pavement maintenance management. 

 

Business Systems Process Overview 

Please see Chapter 1 - Section 2 of the SHAMM for an overview of the business 

systems designed to achieve coordinated and systematic pavement maintenance 

management at the project level. 

The adoption of standardised business systems is important to ensure consistency 

of output across the network. The business systems establish a uniform framework 

without constraining the input of suppliers in developing maintenance strategies. 

This section of the SHAMM covers Investment Levels, the Management Cycle, 

the Roles of Participants and Business Practices. 

 

Information Requirements 

The key to successful asset maintenance management is the collection of 

sufficient, reliable data about the asset, collating this data into information and 

interpreting this information to obtain intelligence. To be valid and appropriate 

the data must be: 

• Relevant to the management decisions being made. 

• Affordable and cost-effective so that regular collection and updating can be sustained. 

• Reliable and adequately accurate for the intended purpose. 

• Readily accessible and in a format suitable for those who need to manage and evaluate 

maintenance practices. 

Chapter 1 - Section 7 of the SHAMM discusses this in detail,  covering the 

following topics: 
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• Use of Data in the Management Process. 

• Maintenance Costs. 

• Crash Data 

• Traffic Data 

• Pavement Condition 

• Pavement Strength 

• Skidding Resistance 

• Road Geometry 

• Environmental Factors 

• Future Developments on Data Collection 

• RAMM Inventory Data and RAMM Outputs 

• Presentation of a Multi-Year Works Programme 

• Trends and Exceptions. 

 

The Intellectual Process 

There is a process to ensure that the current data are used to make intelligent 

decisions in the future. The process includes: 

• The collation and interpretation of all available data 

• The application of intelligent decision support systems 

• Field verification 

• Consideration of all resulting information to resolve the application of the right 

treatments at the right time in compiling the Forward Work Programme. 

See Chapter 1 – Section 8 of the SHAMM which covers the following topics in 

more detail: 

• The Process. 

• Collation and Interpretation of Data 

• Intelligent Decision Support Systems 

• Field Assessment and Verification 

• Programme Preparation. 
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A Treatment Length is a section of a Road which is performing in the same way or 

has had similar treatment applied to it. 

Each Treatment Length should be different from the adjoining sections.  

The initial assessment of Treatment Length should be based on the top surface 

layer. 

It should also be based on the changes in chip type or other surfacing treatment. 

When a seal length is not performing in a uniform manner, the Treatment Length 

should be redefined to restore uniformity within the Treatment Length. 
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Initial Selection 

The initial assessment of Treatment Length should be based on the top surface 

layer. 

It should also be based on the changes in chip type or other surfacing treatment. 

 

Refinement 

When it becomes obvious that a seal length is not performing in a uniform 

manner, the Treatment Length shall be redefined to restore uniformity within the 

Treatment Length. Some maintenance treatments may extend beyond a single 

Treatment Length and provide a greater length of uniformly performing 

pavement. Treatment Lengths should be extended or deleted under such 

circumstances. See Maintaining the Programme (on page 45) for more 

information. 

 

Prerequisites for Generation 

Before generating Treatment Lengths, the RAMM database must contain: 

•  A Treatment Group that includes a check for all reseals 

• At least one Treatment which you're happy to set as the Birthday Seal for all generated 

Treatment Lengths 

• At least one Reason which you are happy to set as the default Reason for the Birthday 

Seal 

• For the chosen Reason, select one Primary Motivator from those available to use as the 

default Primary Motivator for the Birthday Seal. 

If you do not choose to Generate Birthday Seals, the Treatment Length 

Generation process will not create a Forward Work Programme for you. 

 

Generating Treatment Lengths 

In order to make use of the RAMM Forward Work Planning tool you need to have 

defined Treatment Lengths for your network. Whilst a full discussion of 

Treatment Length generation is outside the scope of this document it is useful to 

know the basics in order to create Treatment Lengths from the Top Surface data. 
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Access to the Treatment Length Generation process is in RAMM Manager from 

the Processes > Treatment Lengths > Generate menu. 

 

 

As indicated in the previous sections, your Treatment Lengths should be generated 

based on the Top Surface information rather than from Carriageways. However, 

Forward Work Planning will work with the Treatment Lengths whichever method 

you choose. If you choose to generate from Top Surface data then you can also 

choose to ignore seal records if they are too narrow or too short and have RAMM 

stretch other seals to make them join. 

Finally, you can also have RAMM create a default Forward Work Programme for 

you as it creates Treatment Lengths. If you choose the option to Generate Birthday 

Seals, RAMM will set up a Current Programme for you and place into it the 

Treatment, Reason and Primary Motivator that you indicate apply to the Birthday 

Seal. The Planning Year in which the Birthday Seal takes place is determined from 

the Age and the Expected Life of the surfaces. 

 

Disabled Treatment Lengths 

As a consequence of the way RAMM generates Treatment Lengths there are often 

cases where one Treatment Length is actually a duplicate of another one. This 

situation most commonly arises when you have common State Highways or 

Intersections. Alternatively, there may simply be a section of road that you don't 

want to do any Forward Work Planning on, possibly because of its material (for 

example cobblestones). 
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Using the Treatment Length Displacements maintenance window available in 

RAMM (click on the Maintain Displacements button on the Treatment Length 

Grid/Detail window) you can set any Treatment Length to be disabled. 

 

 

Disabled Treatment Lengths can be viewed and are kept up to date by the 

Treatment Length Summarise process, but are not available in the Forward Work 

Programme. By default a filter is set for the Treatment Length Grid/Detail to 

remove Disabled Treatment Lengths. Switch the filter off and you will see 

something like this: 

 

 

The two Treatment Lengths highlighted in red are those that are disabled. 

 

Status Check Flags 

Following any change to the start or end location of Treatment Lengths, the status 

flag of the road name is set to Changed. This implies that summary data is now 

invalid. Summary data held against the Treatment Length includes a summary of 

all rating, condition and traffic data. To correct this status, run the Treatment 

Length Summarise process. You can access this process from the Processes > 

Status Check option in RAMM Manager. 
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Open the Treatment Length Tasks and select the Summarise Treatment Length 

data option. To run the process, click the Begin Processing button. The following 

options dialog will open: 

 

 

Unless, you have reason to do so, don't change the defaults on this window. Click 

the OK button to begin the summarise process. 
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RAMM Forward Work Planning requires that there be at least one Forward Work 

Programme defined for each Security Zone in your database. This programme will 

have a Format of Current Programme. The Current Programme is the one 

defined as the one that you are using in the field. 

The Current Programme associated with the Entire Network Security Zone is 

known as the Master Current Programme. This is the definitive view of the 

Forward Work Programme as submitted to the client. 

You can create as many Alternative Scenarios as you require by taking a copy of 

either the Current Programme or one of your other definitions. However, only 

one Programme per Security Zone can be Current in your database. 

At any time you can select one of your Alternative Scenarios and set it to be the 

Current Programme. It will then replace your original Current Programme. 

In  Th is  Chap ter  

Maintaining Treatments in the Programme ............................... 46 

The Planning Grid ...................................................................... 46 

Using the Planning Window....................................................... 55 
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Maintaining the Programme 
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Maintaining Treatments in the Programme 

Maintaining Treatments in the Forward Work Programme involves the review of 

Treatments attached to each of the twenty-year planning periods for each 

Treatment Length. 

This also affects the attachment of Reasons, Maintenance Intervention Strategies 

(MIS), Safety Intervention Strategies (SIS), Notes and Priorities. 

 

Operation 

There are two methods for maintaining the Programme. Both are available in 

RAMM. 

You can access the information from the Treatment Length Grid by clicking on 

the Forward Work button. This method gives you access to the Planning window. 

Alternatively you can access the Planning Grid from the menu Forward Work > 

Planning Grid or by clicking on the Forward Work Programme Planning Grid 

icon  on the toolbar. 

 

Maintenance Rules 

• The default blank cell attached to any of the twenty years for a Treatment Length 

signifies routine maintenance. 

• All treatments in the first three years of this Programme must have a Reason assigned. 

• All Treatment Lengths must have a Maintenance Intervention Strategy assigned. 

• Any change to treatments assigned to Years 1, 2 or 3 will default the MIS to blank. A 

new MIS must be attached before the change can be saved. 

 

The Planning Grid 

The Forward Work Planning Grid is an environment much like Microsoft Excel, 

which allows you to maintain the Forward Work Programme. Access to the 

Planning Grid is via the Forward Work Programme Planning Grid icon  on 

the main RAMM Toolbar or from the menu Forward work > Planning Grid.  

Unlike the Planning Screen the Grid is linked directly to the Road Selection panel. 

Therefore, when you open the Planning Grid you will see the Forward Work 

Programme that applies for the portion of the network currently selected in the 

Road Selection panel. 
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As you enter this window you will be in edit mode. As soon as you make any 

change the Save and Cancel buttons on the toolbar will activate. 

NOTE:  You should save at frequent intervals to avoid losing a 

significant amount of work in the event of a system or hardware crash. 

 

Selecting a Programme 

As a default, the Current Programme will be displayed on this window. However, 

you can select any scenario to work with by clicking on the Main Programme 

combo and choosing one from the list. 

The status message next to the Main Programme combo will tell you whether you 

are able to maintain the selected Programme. 

 

 

 

Selecting an Alternative Scenario 

You can choose to display a second, alternative, Programme in the Planning Grid 

at the same time. To do this, first click on the Alternate button in the toolbar. 

This will display the Alternate Programme combo box for you to select the 

Programme you wish to see. 
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You will notice that the Planning Grid displays the information from the Alternate 

Programme, row by row, underneath the Main Programme data. As you can also 

see this information is greyed out indicating that you can not maintain it. 

The Alternate Programme is there to provide you with additional information. If 

you wish to maintain a Programme you need to select it as the Main Programme. 

 

The Planning Area 

The Planning Area of this window is divided into two areas, divided by a vertical 

bar. To the left of the bar is information that identifies the Treatment Lengths. 

That is the Road, Start and End Displacements and the Treatment Length Name. 

Of these, only the Treatment Length Name can be edited. 

To the right of the divider is the Forward Work Plan for the Treatment Length. 

This are is divided into three columns for each Planning Year. Up to 20 Planning 

Years can be displayed, however, you can use the Layout options to reduce that if 

you require. To the left of the Planning Years are columns for the Cost Set, the 

Maintenance Intervention Strategy and the Safety Intervention Strategies. At the 

extreme right hand side of the Planning Years is one further column that holds the 

Treatment Length Notes. 
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You have three choices when entering data in this Planning Grid. You can open up 

the expansion for each cell and select your Treatments, Reasons, etc. from the lists 

presented to you (a text area is displayed in the case of Notes). Alternatively you 

can type directly in the cell. The cell will accept a valid Treatment or Reason code 

along with the associated information such as Coverage or Primary Motivator. Be 

careful if you type directly in the cells. Strict formatting rules need to be followed, 

otherwise you will be presented with a series of error messages when RAMM 

assumes that you have entered invalid codes. 

Enter one or more Treatments by typing in the codes, separated by a comma and 

space. For example: BURN, DI, DM. If you wish to enter a Coverage or Priority, 

put them in brackets after the Treatment, separated by a comma. For example: 

BURN(50,H). If you do not enter the Coverage or Priority, RAMM will assume 

100% and Medium respectively. 

A similar structure is used for the Reasons and Primary Motivator. For example: 

BB(EF), BL(PP). 

Reason Notes can be typed directly in the cell or you can click on the expansion 

button (on the right of the cell) and a text box will open. 

Treatment Length Notes are more complex to deal with as they are associated with 

a length of Road that does not necessarily correspond to the Treatment Length. 

Therefore, the only way to enter a Treatment Length Note is via the expansion 

dialog (see "Treatment Length Notes" on page 63). The most recent note, 

applicable to the Treatment Length is displayed. For this reason, Treatment 

Length Notes are also excluded from the Copy/Paste functions detailed below. 

The third method for maintaining the Programme is to make use of the copy and 

paste functions to either copy information between cells or Treatment Lengths. 

You could also copy to Excel, maintain the information there and copy it back in 

to the Planning Grid later. 

 

Selecting a Treatment 

When you open the Treatment expansion you will see a list of all the Treatments 

that are valid for the Planning Year you are working with. 
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Select one or more Treatments by clicking in the tick box. Coverage can be 

entered by clicking in the Coverage column next to the selected Treatment. 

Similarly, you can choose to set the Priority for the Treatment. 

 

Selecting a Reason 

Opening the Reason expansion displays a list of the Reasons that are associated 

with the Treatments. You can select one or more Reasons from the list by clicking 

on the tick box. 

 

 

Choose the Primary Motivator for your Reason by clicking in the Primary 

Motivator column next to the selected Reason. 

 

Reason Notes 

You can choose to type a Reason Note directly into the cell. If you prefer to work 

with a larger text area then click on the expansion icon that appears on the right of 

the cell when you click on it. 

 

 

 

Treatment Length Notes 

Treatment Length Notes are displayed in the column at the right hand side of the 

Planning Grid. If you wish to see more details, then click on the expansion button 

that is visible when you click on the cell to display the Treatment Length Note 

(see "Treatment Length Notes" on page 63) dialog. 
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Copy Functions 

You use standard Windows Clipboard Copy and Paste functions to transfer 

information into the Planning Grid. Exercise caution. The way information is 

recorded for a Forward Work Programme and the relationships between the 

component parts are complex. Here are some copy functions to perform: 

• Copy the Treatment, Reason and Reason Note from one Planning Year and paste it into 

one or more others. 

• Copy all the displayed information (everything to the right of the black bar in the image 

below) for a single Treatment Length and paste it into one or more other Treatment 

Lengths. 

• Copy the highlighted row, or partial row and paste it into an Excel spreadsheet. 

• Copy an entire Reference Station or Road ID and paste it into an Excel spreadsheet. 

• Copy the highlighted information from Excel and paste it into the highlighted row in 

the Planning Grid. 

►  To  Copy  P lanned  Trea tme n ts ,  Reason s  and  Reason  No t es  f ro m 

One  Year  to  A no ther  

To copy the Planned Treatments, Reasons and Reason Notes from a given Year 

simply click on any one of the three cells that make up that Planning Year and 

press CTRL+C. 

To paste this information into another Planning Year, you click on any one of the 

Cells within that Year and press CTRL+V. The row will be highlighted in a 

colour as in the image below. 
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►  To  Copy  and  Pas te  a  Row  

Copying and Pasting a row works in a similar way to that for a Planning Year. 

Click anywhere on the Treatment Length row that you wish to copy and press 

CTRL+C. Then click on the destination Treatment Length and press CTRL+V. 

 

Copying To and Pasting From Excel 

You can copy to and paste information from Excel in the Planning Grid using 

standard Windows Clipboard commands. To copy, first highlight all the cells that 

you require and press CTRL+C on your keyboard. Paste the information inside 

Excel in the normal way with CTRL+V. To paste information from Excel into the 

Forward Work Plan you simply highlight and copy the cells from Excel in the 

normal way. Click on the first cell (the topmost cell immediately to the right of the black 

line of the paste area) and press CTRL+V. 

WARNING: Take care that you choose the correct starting position for your 

paste when bringing in data from Excel.  The Planning Grid does not 

validate the information as you paste it in and will not care if you put 

Treatments in Reasons, or Reasons in Reason Notes, etc.  It will, 

however, validate the data when you hit the Save button, resulting in a 

large number of errors if you haven't pasted the data correctly. 

►  Copy ing  and  Pas t ing  T o  E xce l  

1 Select the Reference Station in the Road Selection panel. 

NOTE: To copy an entire Reference Station, click the Toggle 

Multi-Select Mode button to enable multi-select mode. 

2 Highlight the information you want to copy and press CTRL+C. 
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3 Open Excel and press CTRL+V to paste the information into a file or cells. 

NOTE: To export the entire Reference Station as an Excel spreadsheet, 

click the Export File button  from the Grid toolbar, select Excel 

and choose a file name and location to save to. 

►  Copy ing  and  Pas t ing  Fro m Exce l  

1 In Excel, highlight the section you want to paste back into the Forward Work 

Programme and copy it to the Windows clipboard (CTRL+C). 

 

 

2 Select the start point to paste the clipboard contents into the Forward Work 

Programme (see the cell indicated by the mouse arrow below). Press CTRL+V. 
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RAMM now pastes the data you copied in Excel at the selected point and shows the 

new data highlighted in a different colour. 

 

 

 

Grid Toolbar 

The Planning Grid makes use of the standard Grid tool in RAMM. For more 

information on using the Grid toolbar please see the Using RAMM Manual. 
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Validation Rules 

The rules for validation of Treatments, Reasons, Primary Motivators and 

Maintenance Intervention Strategies are the same for the Planning Grid as they are 

for the Planning window (described below). 

 

Using the Planning Window 

The Planning window allows you to access the Forward Work Programme for a 

preselected range of Treatment Lengths. 

To access this window, first open the Treatment Length Grid or Detail from the 

main RAMM Toolbar. 

 

 

Once you have selected which Treatment Lengths you wish to maintain click on 

the Forward Work button. This will then display the Planning window. 
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All the Treatment Lengths that are currently available in the Grid are maintainable 

from this window whether or not you have called it from the Treatment Length 

Grid or Detail. 

We look at the main part of the window in more detail in Planning Area (on page 

59) below. First, let's have a look at the contents of each of the tabs at the bottom 

of the window. 

 

General 

 

 

This tab allows you access to the general information about the Treatment Length 

and the Programme as it relates to that Treatment Length. 
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Treatment Length 

The Treatment Length Group displays the Name, Displacements and Cost Set 

that apply to the currently selected Treatment Length. You can change the Name 

of the Treatment Length. You can select a new Cost Set for it from those available. 

However, you can not maintain Treatment Length Displacements from this 

window. Treatment Length displacements can only be maintained by clicking on 

the Maintain Displacements button from the Treatment Length Grid or Detail. 

 

Status 

The Status displayed on this window gives you information on where the 

Treatments for this Treatment Length are in the Planning Cycle. 

A Status of Please revise has come from the Review Process and indicates that the 

New Zealand Transport Agency (NZTA)  would like the Consultant to look at 

this proposed work again and come up with a new recommendation. 

A Status of Ok indicates that the Planned Treatments for this Treatment Length 

have been reviewed and approved by NZTA. 

A Status of Proposed indicates that this is the recommendation for this Treatment 

Length, but that it has not yet been approved by NZTA. 

A Status of Changed indicates that the Consultant has made a change to the 

Treatments, Reasons, Primary Motivators, MIS, or SIS for this Treatment Length. 

A Status of dTIMS indicates that the Plan you are looking at has been loaded into a 

Forward Work Programme from a dTIMS Analysis. 

 

Notes 

This area of the window displays the Treatment Length level notes that are 

associated with the selected Forward Work Programme. 

See the section on Treatment Length Notes (on page 63) for more information. 

 

Review Notes 

Review Notes are entered by the New Zealand Transport Agency (NZTA) during 

the Review process. See the section on Reviewing the Forward Work Programme 

(on page 106) for more information. 
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Intervention Strategies 

 

 

All Treatment Lengths must have a Maintenance Intervention Strategy selected. 

Select one from those defined for the Security Zone appropriate for the current 

Treatment Length. 

If you make any change to the Treatments in Years 1, 2 or 3, then RAMM will 

automatically remove the MIS associated with the Treatment Length. This is 

intended to ensure that you consider which strategy is most appropriate. You must 

select a new MIS for the Treatment Length before you can save the changes. 

See the section on Maintaining Maintenance Intervention Strategies (see 

"Maintaining Maintenance Intervention Strategies (MIS)" on page 70) for more 

information on adding and updating these codes. 

Other strategies are defined as Safety Intervention Strategy codes. You can choose 

one or more from the list of Safety Intervention Strategies. You are not required to 

choose one, so you may leave them deselected if you wish. 

 

Year 2 MARG Weightings 

 

 

This is one of the places where you can see and calculate MARG values for the 

Treatments in Year 2 of the Programme. 

See Project Ranking (on page 175) for more information. 

 



 

 C h a p t e r  7   –   M a i n t a i n i n g  t h e  P r o g r a m m e  5 9   

Planning Area 

 

 

 

Main Programme 

The Main Programme is the one that you wish to maintain. Typically this will be 

the Current Programme and the field will default to this. 

 

Main Programme Lock/Edit Status 

This field, which is next to the Main Programme field, tells you whether you can 

edit the Main Programme that you selected. There are two pieces of information 

here. The first tells you if the Programme is Locked or Unlocked. The second says 

whether you have the authority to edit the Programme even if it is Unlocked. 

A Programme may be Locked because someone has made a decision to protect it 

from change. If the Programme has been unloaded it will also be Locked to stop 

you from changing it until it is returned. 

Whether you can edit Unlocked Programmes depends on what Security 

Permissions you have and on whether you are looking at the Programme in the 

New Zealand Transport Agency (NZTA) main database or a Consultant's database 

for the Network Management Area. NZTA may not modify the Current 

Programme, although they may create a copy and edit it. 
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Alternate Programme 

Click on the Alternate button to expand the Planning window in order to display 

an Alternative Scenario. 

The Alternative Programme is displayed for reference only. You can not make any 

changes to this Programme. If you wish to update an Alternative Scenario you 

must select it as the Main Programme. 

 

dTIMS Analysis Date 

If you have chosen to display a Programme derived from dTIMS data loaded into 

Forward Work Planning, then this field will show you the date when the original 

dTIMS Analysis was carried out. This might have a bearing on the relevance of 

this data today. 

 

Main Programme Planning Year Cells 

There are cells in the Main Programme part of the window for each year of the 

20-year Planning Period. The first ten years are shown when the window is 

displayed. You can scroll to the right hand side to see the rest. The first year on the 

left hand side is considered to be Year 1, the current year. 

Each cell consists of two rows. The top row is used to display the code for those 

Treatments that you have selected for that year. You select Treatments by 

displaying the Treatment Toolbar (see "The Treatment Toolbar" on page 61) and 

ticking the ones that you require. Within the cell the codes are displayed separated 

by a comma. If you have specified coverage for the Treatment, this is also 

displayed, in brackets, next to the Treatment code. You can choose up to five 

Treatments as you require. Typically, this would be one or two. Display the 

Treatment Toolbar to clearly see which Treatments have been applied in that year. 

For each Treatment that you tick you also have the ability to define the coverage 

that you require and to indicate your estimate of the Priority that should be 

accorded to the Treatment. 

The second row of the Programme Cell is used to display the Reason and Primary 

Motivator for the Treatment(s). Once again the Reasons are displayed as codes 

with commas separating them. The Primary Motivator for a Reason is displayed in 

brackets next to the Reason to which it applies. Reasons are selected by displaying 

the Reason tab on the Treatment Toolbar and ticking the Reason(s) that you 

require. For each Reason in the first four years, you select you need to choose the 

Primary Motivator which best fits with the circumstances. 
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In the Forward Work Planning window shown above you can see that some cells 

have a small icon next to the Reason. This indicates that a Reason Note has been 

entered for that Planning Year. These notes can only be seen by displaying the 

Treatment Toolbar. You can enter Reason Notes at any time. However, some 

Reasons require you to enter an explanatory note. 

If a cell is empty, that is you have not expressly assigned a Treatment to that Year, 

RAMM takes this to mean that Routine Maintenance will be taking place on that 

Treatment Length in that Year. 

 

Alternate Programme Planning Year Cells 

The Planning Years for the Alternate Programme are kept in alignment with those 

from the Main Programme. At no time can you edit the information displayed and 

this portion of the window is grey to indicate that it is read only. 

 

The Treatment Toolbar 

Click on the Treatment button or double click on any treatment cell in the 

Twenty-Year Programme to open the Treatment Toolbar. Once displayed this 

toolbar will remain visible and float above the other windows until closed. 

The toolbar will initially open up to be displayed as follows: 
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If you want to see the Notes you can click on the Notes button. If you wish to see 

all the information at once, also click on the Expand button. 

 

The Treatment Toolbar keeps track of which cell on the Planning window you are 

currently in and displays the Treatments, Reasons and Reason Notes that you have 

entered. Treatments and Reasons will be listed alphabetically unless they were 

already selected for the cell before you clicked on it. Preselected Treatments and 

Reasons will always appear at the top of the window. 

 

Programme Period 

All Treatments are assigned to a Programme Period. That is they are only available 

for entry into predefined years of the Forward Work Programme. The Treatment 

Toolbar takes this into account. Treatments that are not available for the 

highlighted Planning Year do not appear on the Toolbar. 

The End of Year Rollover process advances all information from each Planning 

Year forward one year. This often causes a Treatment that was valid for one Year 

to be moved into a Year where it is not allowed. Forward Work Planning does not 

remove this Treatment, it is up to the Consultant to review the Plan and propose a 

valid alternative. Therefore, until it is removed, it will appear in the cell and on the 

Toolbar. 

Invalid Treatments that appear on the Treatment Toolbar can be unticked and 

ticked only so long as the Toolbar remains open and you do not move from the 

highlighted Planning Year. Once you untick the invalid Treatment and either 

close the Toolbar or move to work with another Planning Year, the invalid 

Treatment will disappear and you will not be able to add it again to that Year. 
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Treatment Coverage and Priority 

On the Treatment tab of the Toolbar you can see two additional pieces of 

information that are displayed to the right of any selected Treatment. They are the 

Percentage Coverage and the Treatment Priority. 

The Treatment Priority can be used to indicate how important it is that the 

selected Treatment be carried out. This flag allows you to give your considered 

opinion independently of any automatic calculation of Treatment Priority, such as 

MARG. By default, the Priority is set to Medium, but you can change this to 

either High or Low. 

 

Reason Primary Motivator 

On the Reason tab of the Treatment Toolbar you can see an additional column of 

information for each of the selected Reasons. This is the Primary Motivator for 

the Reason. Not all Reasons require a Primary Motivator, but for those that do 

you will see a field here from which a listing of the Primary Motivators is available 

to you. 

All Reasons that are assigned to Treatments in the first three Planning Years must 

have a Primary Motivator assigned to them, if they have been defined. 

 

Treatment Length Notes 

Treatment Length Notes are accessible from both the Forward Work Planning 

window and Grid. They are intended as a way of associating general or review 

information with a length of the network rather than with a specific 

Treatment/Reason combination. 

Clicking on the Edit or New button in the Notes area on the Planning window 

displays the following dialog. A similar dialog is launched by clicking the  

button in the Notes cell on the Planning Grid. 
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The reason for entering and maintaining these notes in a separate window is 

because they are associated with a length of the network. You can associate the 

note with any start and end displacement without recourse to the start and end of 

the Treatment Length. 

Multiple notes can be entered for a single Treatment Length. 

When displayed on the Planning window or grid, the notes will be visible against 

the Treatment Length they apply to. 

In addition to defining the Start and End Displacement for the note you need to 

select one of the Note Types that you have defined. 

Enter the note in the text box at the bottom of the window. The Added On and 

Added By information will be automatically populated for you. 

In addition you can choose to have this note available for all the Forward Work 

Programmes in your database by ticking the All Programmes check box. Should 

you either ignore or deliberately untick this tickbox then this note will only be 

displayed for the Programme you were working on when you entered it. 

Finally, you can also choose to have this note displayed prominently when you 

move onto the Treatment Length. Do this by clicking on the Bring-up tick box. 

 

Programme Status Flags 

Any change to the Treatments assigned to a Treatment Length, the reasons, MIS, 

or SIS will alter the status of the Treatment Length to Changed. This status change 

is used in the approval process of the programme. The following rules apply: 

• A consultant does not have access to the Approve/Reject status change. 

• The New Zealand Transport Agency (NZTA) staff have no access to change 

treatments (thus effecting a status change to Changed). 
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Maintenance works should normally be considered for implementation once the 

maintenance intervention level has been reached or exceeded. 

For a full discussion on the application of maintenance interventions, the highway 

environment, and intervention levels see Chapter 1 – Section 5 of the SHAMM. 

 

Maintenance Interventions 
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A Maintenance Intervention Strategy is a detailed statement of the type of 

maintenance activity that should be targeted to the Treatment Lengths identified 

in the Forward Work Programme. 

It is the principle method of conveying the appropriate activities to all parties 

involved in the maintenance of an asset. 

Maintenance Intervention Strategies are designed to ensure the optimum use of 

maintenance funding by ensuring that routine activities are appropriate given the 

programmed treatments. 

A more detailed discussion of Maintenance Intervention Strategies, covering 

objectives, alignment with policy, and typical strategies is found in Chapter 1 – 

Section 6 of the SHAMM. 

In  Th is  Chap ter  

Maintenance Intervention Strategy Codes ................................. 70 

MIS Costs .................................................................................... 70 

Maintaining Maintenance Intervention Strategies (MIS) .......... 70 
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Selecting MIS Definitions for the Security Zone ....................... 72 

 

 

 

Maintenance Intervention Strategies 
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Maintenance Intervention Strategy Codes 

The Maintenance Intervention Strategies used may vary between Security Zones. 

However, the maintenance of these codes is done nationally. 

Please contact the New Zealand Transport Agency (NZTA) to arrange for new 

codes to be added. 

These codes may then be delivered to Consultants using the Manage Records 

function or via the National Table Export and Import. See National Tables Export 

(on page 170) and National Tables Import (on page 172). 

 

MIS Costs 

All Maintenance Intervention Strategies have costs associated with them. 

Even if the MIS Codes are common between the Security Zones, it is unlikely that 

the costs will be common. 

It is the responsibility of the Consultant, therefore, to define the MIS costs for 

their region. 

 

Maintaining Maintenance Intervention Strategies (MIS) 

In order to keep consistency among MIS definitions, there is one master list of 

Maintenance Intervention Strategies defined for your database. 

To maintain this list, you first need to log in to the Entire Network Security Zone. 

If you are logged in to the Security Zone corresponding to your Network 

Management Area, then you can select MIS definitions from this Master List to be 

available to you when managing your Forward Work Programme. 

 

Maintaining the Master List 

The MIS Master List is maintained in RAMM Manager when logged in to the 

Entire Network Security Zone. 

Follow the menu path Projects > Forward Work > Maintenance Intervention 

Strategies. 
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When the screen opens it displays the MIS definitions selected for use in this 

Security Zone. 

To maintain this master list follow the menu path Mode > Master List. 

 

 

When you insert a new MIS Definition you will be asked if you want it to also be 

available for use within the Security Zone. 

If you say Yes, a dialog box will open listing all the active Security Zones in your 

database. 
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Select the Security Zones to which your new Definition is to be made available. 

You then press the Apply button. 

When you remove one of your definitions, it will be removed from the Security 

Zone lists as well. 

However, if this code is currently in use in any of your Forward Work 

Programmes, you will not be allowed to delete it. 

Instead, the MIS Definition will be flagged as not being Active. 

 

Selecting MIS Definitions for the Security Zone 

You select, from the Master List of Maintenance Intervention Strategies, 

Definitions which are to be available for your Security Zone. 

Log in to your Security Zones using RAMM Manager. 

Follow the menu path Projects > Forward Work > Maintenance Intervention 

Strategies. 

A screen will open with a list of all MIS Definitions currently available for use 

within your Security Zone. 

 

 

If you wish to add or remove items from the list then press the Manage Records 

button . 
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The Manage Records dialog box will open. 

 

 

By default, this screen lists the codes which you have not selected for your 

Security Zone. 

Select the required MIS Definitions and then press the Apply button to add them 

to your Security Zone List. 

If you wish to remove a particular definition from your Security Zone list, you 

clear the check box adjacent to the definition and then press the Apply button. 

Within the Security Zone you will need to define Unit MIS Costs in $/m
2

 for each 

of the Cost Sets you have available to you. 

This can be done by editing the records in this table to the right of the screen. 
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See Chapter 2 – Sections 1 to 5 of the SHAMM for a discussion of the processes 

necessary to ensure the safety of the State Highway network.  The process is 

determined by the preparation, implementation, and review of the Safety 

Management Strategy. 
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Safety Intervention Strategies 

A Safety Intervention Strategy (SIS) forms part of the Safety Management Strategy 

as defined in Chapter 2 – Section 6 of the SHAMM. 

This document discusses the definition and purpose of a SIS, intervention levels, 

considerations and a hazard register. 

 

Maintaining Safety Intervention Strategies 

To keep definitions consistent across all users of the Forward Work Programme, 

there is one Master List of Safety Intervention Strategies (SISs) defined for your 

database. 

To maintain this list you first log in to the Entire Network Security Zone. 

If you are logged in to the Security Zone corresponding to your Network 

Management Area, then you can select SIS definitions from the Master List to be 

available while managing your Forward Work Programme. 

 

Maintaining the Master List 

The Security Intervention Strategy (SIS) Master List is maintained in RAMM 

Manager when logged in to the Entire Network Security Zone. You follow the 

menu path Projects > Forward Work > Safety Intervention Strategies. A screen 

will open with the SIS Definitions selected for use in this Security Zone displayed. 

You follow the menu path Mode > Master List to maintain the Master List, . 

 

 

When you insert a new SIS Definition, you will be asked if you want it to be made 

available for use within the Security Zone. If you select Yes, a dialog box will open 

with a list of all the active Security Zones in your database. 
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You select the check boxes for the Security Zones for which your Definition is to 

be made available and clear those to which it is not to be made available. You then 

press the Apply button. 

When you remove one of your definitions, it will be removed from the Security 

Zone as well. However, if the code is currently in use in any of your Forward 

Work Programmes, you will not be allowed to delete it. Instead, the SIS Definition 

will be flagged as not being active. 

 

Selecting SIS Definitions for the Security Zone 

To make Security Intervention Strategy (SIS) Definitions available for your 

Security Zone, you select the ones you want from the Master List. You log in to 

your Security Zone using RAMM Manager. You follow the menu path Projects > 

Forward Work > Safety Intervention Strategies. A screen will open listing the SIS 

Definitions currently available for use within your Security Zone.  

 

 

If you wish to add or remove items from this list you press the Manage Records 

button .  The Manage Records dialog box will open. 
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This screen will display only those SIS Definitions which have not been selected 

for your Security Zone. Select those SIS Definitions which you want to add and 

press the Apply button to add them to your Security Zone. 
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After an End of Year Rollover 

If you have just set up a Forward Work Programme or it is not the beginning of a 

new Financial Year and you have not run the End of Year Rollover process you can 

ignore the rest of this section. However, if you have just performed an End of Year 

Rollover or are working with a Database which has recently been rolled over, then 

you should perform some checks on the integrity of your Forward Work 

Programmes. RAMM has a range of reports for this purpose. You access them 

from RAMM Manager and run them consecutively. Follow the menu path 

Reports > Forward Work > Integrity. See End of Year Rollover (on page 162). 

 

Programme Integrity Reports Options 

When you run the Programme Integrity reports, the first screen you see is the 

Options dialog box. 

 

 

You choose, from the list of your login and child Security Zones, the Zone on 

which you want to report. Then, from within the Security Zone, you select the 

Forward Work Programmes you want to analyse. Finally, you select one or more 

of the Programme Integrity reports listed in the lower section of the screen. 
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Out-of-date Treatments Report 

Treatments are defined as being valid for certain periods within the twenty year 

Forward Work Programme. When End of Year Rollover takes place Treatments 

that were, for example, valid for Year 4 have been moved into Year 3. However, 

some of the Treatments may not be valid for use in Year 3. This report locates 

these Treatments in the Programme. You can then correct the records. 

 

 

 

Inactive Treatments Report 

The Master List of Forward Work Programme Treatments is defined and 

maintained by the New Zealand Transport Agency (NZTA). From time to time, 

NZTA will decide that a Treatment is no longer to be used and will flag it as 

inactive. However, this does not automatically remove this treatment from any 

Forward Work Programme where it is currently being used. This report locates 

the Inactive Treatments. You can then replace them. 
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Missing or Zero Treatment Cost Report 

Each treatment has an individual cost defined for it. 

This enables estimation of the financial cost of the Planned Treatment in your 

Forward Work Programme.  

The default value for a treatment is $0.00/m
2

. 

It is possible that by design or error, that a particular Treatment may not have been 

given a financial cost at all. 

This report identifies those Treatments which have no real cost assigned to them. 

You can then assign a real cost. 
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Missing Reasons Report 

When you are planning Treatments in the first three years of your Forward Work 

Programme you are required to indicate the Reason why this work is required. 

Further out into the Programme, it is not mandatory to record a Reason for your 

proposed Treatment beyond the fourth year. So when you run the End of Year 

Rollover process, it is possible that a Treatment which has no Reason associated 

with it will move into that section of the Programme which requires one. 

This report locates such Treatments in your Programme. You can then assign a 

Reason. 
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Inactive Reasons Report 

The Master List of Forward Work Treatment Reasons is defined and Maintained 

by the New Zealand Transport Agency (NZTA). From time to time, NZTA will 

decide that a Reason is no longer to be used and will flag it as Inactive. However, 

this does not automatically remove this Reason from any Forward Work 

Programme where it is currently being used. 

This report locates the inactive Reasons. You can then replace them. 
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Missing Primary Motivators Report 

Many Treatment Reasons have one or more Primary Motivators associated with 

them. Whilst you do not need to assign a Primary Motivator to a Reason in Years 6 

to 20, you do need to assign one, where they apply, to the Reasons in Years 1 to 5. 

After the End of Year Rollover, the Treatments and Reasons in Year 6 will now be 

in Year 5. 

This report locates the Reasons which now need Primary Motivators. You can 

then associate the appropriate Primary Motivators. 
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Missing Maintenance Intervention Strategies 

Every Treatment Length, where treatments are planned in any year of the Forward 

Work Programme, requires a Maintenance Intervention Strategy (MIS). RAMM 

also requires you to consider your MIS every time you make a change to the 

planned treatments in years one, two or three. RAMM does this by removing the 

associated MIS from the Treatment Length. 

When you perform the End of Year Rollover, Treatments in year one are placed 

into history. Those in years two, three and four are moved forward one year. 

These are all changes which affect the first three years of the programme and so 

the MIS will be removed. 

This report locates the Treatment Lengths which need a MIS. You can then 

associate the appropriate MIS with the Treatment Length. 
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Inactive Maintenance Intervention Strategies Report 

The Master List of Maintenance Intervention Strategies (MIS) is defined and 

Maintained by the New Zealand Transport Agency (NZTA). From time to time, 

NZTA will decide that a MIS is no longer to be used and will flag it as Inactive. 

However, this does not automatically remove this MIS from any Forward Work 

Programme where it is currently being used. 

This report locates each inactive MIS and lists them. You can then replace them. 
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Missing or Zero Maintenance Intervention Strategies Costs Report 

Each Maintenance Intervention Strategy (MIS) has an individual cost defined for 

it. The default value for a MIS is $0.00/m
2

. It is possible that by design or error, 

that a particular MIS may not have been given a financial cost at all. 

This report identifies and lists each MIS which has no real cost associated with it. 

You can then associate a real cost with them. 

 

 

 

Inactive Safety Intervention Strategies Report 

The Master List of Safety Intervention Strategies (SIS) is defined and Maintained 

by the New Zealand Transport Agency (NZTA). 

From time to time, NZTA will decide that a SIS is no longer to be used and will 

flag it as Inactive.  

However, this does not automatically remove this SIS from any Forward Work 

Programme where it is currently being used. 

This report locates and lists each inactive SIS. You can then replace them. 
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Missing Cost Sets Report 

Cost Sets are used to distinguish between the differing costs for the same 

Treatments which result from geographical or other considerations. In order for 

the Planned Treatments to be costed for a Forward Work Programme, all 

Treatment Lengths require an associated Cost Set from those available in the 

Security Zone. 

This report locates Treatment Lengths with no associated Cost Set. You can then 

associate an appropriate one. 

 

 

 

Inactive Cost Sets 

From time to time, you will decide that a Cost Set is no longer to be used in your 

Security Zone and will flag it as Inactive. 

However, this does not automatically remove this Reason from any Treatment 

Length where it is currently being used. 

This report locates the inactive Cost Sets. 

You can then replace them. 
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Trends and Exceptions 

The collation of data does not itself provide the means of identifying problem 

sites. 

The interpretation of the data is important, as this is the process which identifies 

the trends and exceptions essential for the early identification of faults and the 

subsequent selection of treatments for each Treatment Length. 

Chapter 1 - Section 7.13 of the SHAMM discussed the types of indicators, 

interventions and customised indicators for trends and exceptions. 

 

Exception Maintenance 

Overview 

You can use exceptions to search through Treatment Length summary data 

finding Treatment Lengths that are performing abnormally. Run this from the 

Projects > Forward Work > Exceptions menu from RAMM Manager.  

An exception can be based on either, a filter or an SQL query you have created. 

You can also start by using the filter tool to develop the exception and switch to 

SQL when more complex searches are required than the filter tool offers. 

However, once you switch to SQL you can no longer access the exception as a 

filter. 

When running an exception all Treatment Lengths matching the criteria you have 

specified are tagged with the code of that exception. These tags remain against the 

Treatment Length until you clear them or rerun the exception. 

To find all the Treatment Lengths tagged by an exception use RAMM. Click on 

the Treatment Length icon and filter the grid for Treatment Lengths with that 

exception code. 
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To create a new Exception definition you first need to insert a new record, 

selecting a Network Management Area, giving it a unique Exception Code and a 

Description. You can also add some explanatory notes if you wish. 

Once you have your basic definition you need to add the selection criteria. Do this 

by clicking on the Edit Filters button. This will cause the following window to be 

displayed. 

 

 

Filtering information for Treatment Lengths is complex as a result of the diverse 

range of tables that hold Treatment Length related data. 

Therefore, you will need to choose what type of Treatment Length information 

you want to search for using the following window. 
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In this example we have chosen to search for information from the Treatment 

Length details and Latest summary data. This causes a Filter Dialog to be 

displayed as follows. 

 

 

Use this in the same way as you would for filtering any asset and select from the 

information available and define the search criteria. 

The following window shows some selection criteria based on the Surface Date 

and First Chip Size. 
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Once you have saved your definition you can look at the SQL that has been 

generated for you based on the selection criteria. The following is the SQL from 

the query described in the last window. 

 

 

As you can see, this SQL is quite complex. However, if you want to alter this SQL 

you can do so by clicking on the Edit button. If you do this you will be warned as 

follows: 

 

 

The reason for this warning is that RAMM will no longer be able to determine the 

component parts of your SQL once you have altered it. Therefore, once you have 

done this there is no going back and you will only be allowed to edit the SQL from 

now on. In edit mode the SQL window looks like this: 

 

 

When you have finished altering the SQL click on Ok to save the changes. As you 

can see from the following example, you can only click on the View (Edit) SQL 

button from now on. 
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Edit Filters 

This allows you to define a Treatment Length filter for the exception. 

 

View (Edit) SQL 

This shows the RAMM SQL matching your filter criteria, used to select 

Treatment Lengths. You can Edit the SQL directly from this screen but will then 

no longer be able to use the filter interface to modify the exception. Use the Edit 

option for queries too complex for the filter, such as using or in a query. 

 

Run Exception 

The exception must be saved before you can run it. The Run Exception button 

runs only the currently displayed exception. The exception code is cleared from all 

Treatment Lengths then reset by running the exception filter or SQL. Other 

exceptions are not affected. 

 

File > Run Multiple Exceptions 

Use this option to run more than one Exception definition at once. 
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Exception List 

Choose the exceptions to run. Unless the exception reset tickbox is selected 

exception codes are only cleared for the exceptions you choose to run. 

 

Exception Reset 

Select this check box to force all exception codes to be cleared from Treatment 

Lengths regardless of whether you choose to run the exception from the Exception 

List box. This does not delete any of your exceptions. Only the codes held against 

Treatment Lengths are cleared. The definition of the exception is unaffected. All 

exceptions defined in the Exception Maintenance window will remain. 

 

Using the Exception 

Once you have created and run the exception it will appear in the Treatment 

Length filter, which is very similar to the mechanism used to create the exception. 

The difference is that the Treatment Length filter provides searching by 

exceptions.  

To do this, select the filter type Exceptions. 
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Note that the Exceptions Filter option is only available from the Treatment 

Length Filter in RAMM. 

 

Why Use Exceptions? 

• Building an exception allows you to develop a search and tag all the Treatment Lengths 

matching the query at that time. You can then close RAMM for Windows and find 

exactly the same set of Treatment Lengths next time by searching for the exception. 

The list of Treatment Lengths found will remain the same until you rerun the 

exception. 

• For complex queries it is much faster to filter for an exception you have already run, 

compared to re-running a complex filter. 

• When necessary you can edit the Exception SQL directly. This is not available for a 

Treatment Length filter. 

 

Forward Work Detail Report 

This is a detailed report of the Twenty-year Programme for the Treatment 

Lengths within the selected Road. 

The report can be configured to look at either the Main Roads or the Ramps. 

It is possible to choose to report on your Current Forward Work Programme or 

one of the alternative scenarios. The report can be further configured to choose 

your Programmes from out of the Security Zone. 

You can access this report from within RAMM using the menu Forward work > 

Detail Report. 

 

 

As you can see from the Options Dialog there are a number of variations of this 

report that you can choose from. 
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Firstly, you can choose to report on the Main Roads or the Ramps Only. You can 

also select which of your Programmes that you want to send to the report. By 

default the Current Programme is selected. You can then choose to filter the 

report down to the Office or Local Area level. 

When Forward Work Planning was first implemented it was designed to support a 

10-year Forward Work Programme. It has since been extended to support a 

20-year Programme. However, for convenience and to save space, you can choose 

to look at only the first 10 years of the Forward Work Plan. 

This report will, by default, show you only the most recent note that applies to 

each Treatment Length. However, you can choose to have all notes displayed in 

the report. See the section on Treatment Length Notes (on page 63) for more 

information on using these notes. 

 

 

The example report shown here is for Main Roads, over 10 years of the Current 

Programme and displays only the most recent notes. 

 

Contractors Programme Report 

The Contractors Programme Report gives you details of the first five years of the 

Forward Work Plan. The format is similar to the Detail Report. 
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Access to this report is in RAMM using the Forward work > Contractors 

Programme Report menu. 

 

 

As you can see from the Options Dialog there are a number of variations of this 

report from which you can choose. 

Firstly, you can choose to report on the Main Roads or the Ramps Only. You can 

also select which of your Programmes that you want to send to the report. By 

default the Current Programme is selected. You can then choose to filter the 

report down to the Office or Local Area level. 

This report will, by default, show you only the most recent note that applies to 

each Treatment Length. However, you can choose to have all notes displayed in 

the report. See the section on Treatment Length Notes for more information on 

using these notes. 
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The example shown here is for Main Roads and is reporting the first five years 

from the Current Programme. Only the most recent notes are displayed. 

 

Field Inspection Report 

The Field Inspection Report contains all the information that you might need, 

from the Forward Work Programme for your Treatment Lengths, to take with you 

into the field when doing an assessment. 

You can choose to extract the data from one or two Programmes (for comparison). 

There are two versions of this report. One is in a fixed format and available to 

print or export to Microsoft Excel. The second is in the form of a Grid that you 

can manipulate in order to display those parts of the data that are of interest to you. 

Many people have their own version of the Field Inspection Report, which have 

been created using MS Excel. Therefore, to make life easier the new Grid Field 

Inspection Report in RAMM can be used to save the data you require directly in 

MS Excel format. You can then use this as the data source for your own report. All 

the data that you require should be available so this provides an easy route to 

getting the information. 

 

Formatted Version 

The formatted version of the Field Inspection Report is available in RAMM under 

the menu Forward Work > Field Inspection Report > Formatted. 
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As you can see from the above options dialog, you can choose one or two Forward 

Work Programmes to be sent to the report. Details from the Main Programme will 

appear above those from the Alternative in the report. By default the Main 

Programme is set to be the Current Programme, but you can change this if you 

wish. 

Along with your choice of Programmes you can also filter the report by the Login 

or Child Security Zone. 

Among the information that is available on this report is the Treatment Selection 

Algorithm recommendation. Since it is possible to run a number of TSA Analyses 

during the course of your review of the network, RAMM needs to know from 

which one to extract the data. 

 

 

This example of the report is in A4 format and is for the Current Programme 

only. 

 

Grid Version 

The grid version of the Field Inspection Report is available in RAMM from the 

Forward Work > Field Inspection Report > Grid menu. 
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This example of the Field Inspection Report Grid has been generated for the 

complete network as present in the database. 

You can choose to run the report for only a portion of the network by choosing 

from the Location options. You will also need to select a TSA Header from those 

available. Once you have made your choices click on the Generate button to 

populate the report grid. 

 

Balancing the Programme 

This window is available in RAMM from the Forward Work > Balancing menu. 
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This formally formatted report is used for audit purposes when a Consultant 

returns the Forward Work Programme to the New Zealand Transport Agency 

(NZTA). Use the options to select filters to apply, such as a Status of All or 

Changed. Use the Security Zone to select the parts of the programme to be 

summarised for balancing. 

Programme Summary reports the total dollars calculated from the appropriate 

Cost Sets for total (total programme) and available (the difference between target 

and total). To enter or edit targets press the Edit Targets button. Enter a value for 

each of the twenty years against each Security Zone. Reseal Cycle Rate is 

calculated by dividing the total length of resealing programmed by the total length 

of the network. Where a Security Zone is selected, the lengths used are those 

relating to the selection. 

Programme Detail reports either dollars ($000) or length (km) for each of the 

Treatments, Treatment Groups, or Funding Groups as selected. The dollars and 

length are calculated on the basis of the Treatments programmed, the length of 

the Treatment Lengths to which they apply and the costs assigned through the 

treatment Cost Set. Any change to the treatments assigned to a Treatment Length, 

the Treatment Length itself, or the costs assigned through the Cost Set will 

invalidate the programme balancing data. The table is flagged as invalid and before 

it can be viewed you need to recalculate the Programme Costs. 

Press Preview Report or follow the menu path Actions > Preview Report for a 

report based on the information on this screen. To print it, click the Print button 

or select Actions > Print. You can also generate an Overview Report graph. 
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Overview Report 

You can generate an Overview Report in graph format from the Forward Work 

Programme balancing window. Click the Overview Report button, or select 

Actions > Overview Report. 
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Editing Programme Targets 

This screen is available in RAMM from the Programme Balancing window by 

using the Actions > Edit Targets menu. 

 

 

Enter Target Values for the twenty Planning Years and those Security Zones that 

require them. All Targets for a given Planning Year are added together and 

displayed in the Programme Summary area of the Balancing window. 

 

 

 

 

Programme Outputs 

Format 

The programme includes the following information: 

• Treatment Length referenced by route position. 

• Treatment Length reference name. 

• Date and type of last seal coat and expected life. 

• Upper pavement moisture sensitivity. 

• Maintenance intervention strategy applicable for the Treatment Length. 
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• Treatments (other than reactive maintenance) against the appropriate financial year. 

• Comments. 

 

Programme Accuracy 

The first year of the programme is the current financial year and represents the 

work programme in progress. 

The second year represents a firm recommendation on works for which funds 

should be sought for treatment in the next financial year. 

The third year presents a reasonable assessment of the needs. There must be some 

tangible evidence supporting the programme for that year. 

Years 4 to 20 represent an engineering assessment based on considerations 

including age, dTIMS CT and expected life. 

 

Pretreatment 

Pretreatment needs, such as drainage works prior to resealing, shall be indicated in 

the programme. 

 

Economic Analysis 

Whenever possible the Year 1 and 2 programmes should be supported by 

economic analysis. This is a prerequisite for pavement reconstruction, seal 

widening and improvement works which should have cost/benefit ratios above the 

current cut-off ratio or otherwise have prior client funding approvals. 

 

Project Development Status 

Construction works shall have the current project development status (Point X or 

Y) as defined in the New Zealand Transport Agency (NZTA) Land Transport 

Programme Development and Management Manual, confirmed in the comments 

section of the programme. 
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Reviewing the Forward Work Programme 

Once the Forward Work Programme has been completed by the Consultant it is 

ready to be reviewed at the New Zealand Transport Agency (NZTA). This section 

details the process by which this takes place. 

 

Review 

The Twenty-Year Programme is subject to constant review. The adequacy of the 

proposed Treatments may change as the pavement deteriorates. Other factors, 

such as crash statistics, may influence improvement works. 

 

Review Frequency 

Two formal reviews of the twenty-year programme are required. 

One review is required once the results of the RAMM Condition Rating Survey, 

Treatment Selection and Roughness Survey have been completed. It needs to be 

timed to coincide with NLTP development. This is generally carried out in 

October. Another review is required once the level of funding for the following 

year is confirmed. Programmes and strategies will need to be aligned to approved 

funding levels. This is generally carried out in May. 

Other reviews may be required whenever any funding changes occur or pavement 

deterioration does not take place as expected. 

 

Basis of the Review 

Whenever a formal review is undertaken all data inputs shall be updated. The 

following actions shall also be undertaken: 

• Adjustments to the current work programme shall be made in accordance with 

physical works achievements. 

• The programme for the following four years shall be reviewed in consideration of the 

best currently available information. 

• Refinement of preventative maintenance or pretreatment programmes shall be 

provided in terms of extent and cost. 

• Priorities shall be determined for works recommended in the following year. 
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Forward Work Programme Review Procedure 

Overview of NZ Transport Agency (RCA) and Consultant Roles In Review Process 

 

 

 

Permissions 

Consultant 

• can edit the Current Programme (provided it is not locked) 

• can not change the Review Programme loaded from the New Zealand Transport 

Agency (NZTA) 

• can copy Programmes to create Alternative Scenarios and then edit these. 
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New Zealand Transport Agency 

• can not edit the Current Programme 

• can add instructions to the Current Programme in the form of Review Notes, so that 

the Consultant can edit the Programme 

• can also copy Programmes to create Scenarios and then edit the Scenarios. 

 

Preparing to Review the Programme 

Reviewing a Forward Work Programme is the responsibility of staff at the New 

Zealand Transport Agency (NZTA). However, some of the steps in this process 

need to be carried out by the Consultant who is maintaining that Programme. 

Therefore, this section describes all the steps taken by both NZTA and the 

Consultant when a Programme Review is being carried out. 

 

Maintaining Review Shortcuts 

Reviewing the Programme is a New Zealand Transport Agency (NZTA) function 

that can only be carried out on the master database held by NZTA. Therefore, the 

ability to define and maintain the Shortcut Keys used in the Review process can 

only be done by NZTA. This window is available in RAMM Manager from the 

menu Projects > Forward Work > Review Shortcuts. 

 

 

This window is used to define a Shortcut Key for a recommendation that you 

might use frequently during the course of a Review. 
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Each Shortcut consists of a Description (the name of the Shortcut), a note that will 

be recorded in the Review Notes area and a set of actions that will be carried out 

on the Treatment affected. 

The Review action comes in three parts: 

1 Treatment Displacement 

This moves the Treatment from its current Planning Year to one either before or after 

the current one. 

2 Status 

This action changes the Status of the Programme for the given Treatment Length. 

3 Priority 

This action changes the Priority associated with the Treatment to give an indication of 

how important it is to carry it out. 

To set the Shortcut Key you click on the Shortcut Key data field and then press 

your choice of keys on the keyboard. Your choice will be displayed in the data field 

and you confirm that it is to be used by clicking the Set Shortcut button. 

 

Programme Balancing Report 

The New Zealand Transport Agency (NZTA) also requires a copy of the 

Balancing Report to accompany the Forward Work Programme files. Please see 

the section on Balancing the Programme (on page 101) for a description on how to 

produce this report. 

 

Starting the Programme Review 

The New Zealand Transport Agency (NZTA) has the ability to formally review 

the Current Forward Work Programme and either approve the proposed work for 

each Treatment Length or make recommendations for alterations. 

NZTA can not make any changes to the Current Programme and can only make 

recommendations that are passed back to the Consultant. 

 

Programme Review 

Programme Reviews can only be carried out by the New Zealand Transport 

Agency (NZTA). The objective of this process is to acknowledge all proposed 

Treatments as acceptable, or alternatively instruct the consultant on changes that 

are to be made. 
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Instructions are issued in the form of review notes attached to Treatment Lengths 

in the current programme. The suggested changes, such as defer one year, are 

reflected in the review programme. The client can gauge the effects of the 

suggested changes by looking at the programme balance for the review 

programme. 

 

Initiating a Review (New Zealand Transport Agency) 

To begin the Review process you must first initiate the review for the Current 

Programme. You can do this in RAMM Manager from the Programme 

Maintenance window by choosing the menu Actions > Review > Initiate. 

Alternatively, if you are using the Planning window in RAMM you can initiate a 

review using the menu Actions > Initiate Review.  

The status of the Programme should be Unlocked but Not Editable before the 

review is initiated and this does not change. 

It is the job of the Consultant to select the appropriate treatments. The New 

Zealand Transport Agency (NZTA) can not edit a current Forward Work 

programme. They can only review it, make comments on it and then return it to 

the Consultant for updating. Physical changes are made on the review copy of the 

programme. 

Once the review is initiated, the Copy Programme for Review window is opened.  

 

 

This screen gives the choice either to review the Programme from the Login 

Security or to make a review copy of the current programme. This review copy 

can by viewed with the current programme in RAMM when the review is being 

performed (see below) so it is recommended that this copy be made. The copy has 

a status of editable by review only. 

 

Reviewing the Programme 

When the Current Programme is in Review the Forward Work Planning window 

looks like this: 
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The Review Mode, Shortcuts and Bulk Review buttons are now available to you. 

 

Review Mode 

This allows you to begin reviewing the Current Forward Work Plan. The the 

Review Shortcuts toolbar opens. 

 

Shortcuts 

This opens the Review Shortcuts toolbar if it has been closed. 

 

Bulk Review 

This opens the Bulk Review window which enables you to review more than one 

Treatment Length at a time. 

 

Working in Review Mode 

To begin reviewing, press the Review Mode button on the toolbar. 

This opens the Review Shortcuts window and allows the New Zealand Transport 

Agency (NZTA) to add notes to the programme by selecting cells and then adding 

the desired instruction by clicking the appropriate button in the Shortcuts 

window. 
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Shortcuts 

The shortcut buttons are designed to attach clear instructions to the Consultant on 

what actions are required. Review notes detailing the instruction are automatically 

attached to the Treatment Length when the buttons are pushed. 

When Please Revise is added to a Treatment Length, there should also be a note 

accompanying this.  

 

 

This note can be added by entering it into the box in the Shortcuts window, then 

pressing the Add to notes button. This results in a note that looks like: 
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This note will then be recorded as a Review Note for this Treatment Length. 

 

Working With Alternative Programmes 

Pressing the Alternate Programme button will bring up the review copy of the 

Current Programme underneath the current programme, or any other programme 

when not in Review Mode. This is to allow two programmes to be compared and 

allows the suggested changes to be physically made on the review copy. If the 

review copy is not open the suggested changes will not be made on it. 

 

 

This review copy shows the changes requested. The current programme is not 

changed - it only has instructions to the Consultant added in the review notes 

window. 

 

Working With Alternative Programmes (Example) 

If you chose to advance the 2005/06 Treatment by one Year you would see the 

following: 

 

 

 

Working with the Bulk Review 

The Bulk Review button  opens the Bulk Review window. 
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This window lists all Treatment Lengths for a Security Zone and allows filtering 

of these Treatment Lengths. A number of Treatments can be selected at once by 

holding down the CTRL key and picking cells and then these can have the same 

instructions added concurrently. For example, a filter may be applied to show all 

low priority Year 2 reseals, then after selecting them all the shortcut button to 

defer all of these by one year can be pressed. 

When viewed in the Bulk Review window, the programme is updated as changes 

are made. So this view behaves the same as the Review copy in that it shows the 

changes requested, not just the instructions. 

 

View > Refresh 

This menu causes the window to be refreshed. 

 

View > Shortcuts 

This menu displays the Shortcuts toolbar if it has been closed. 

 

Filter > Set/Edit Filter 

This menu allows you to set or edit a filter for the Treatment Lengths displayed in 

the Bulk Review window. 

 

Filter > Clear Filter 

This menu clears any filter that you have previously set. 
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Shortcuts - Working With the Bulk Review 

This is a menu alternative to using the buttons on the Review Shortcuts toolbar. 

 

Returning to Normal Mode 

To return to the normal mode of the Forward Work window press the Review 

Mode button once again. 

 

Notes 

Notes can be added to either the Review Notes window or the Treatment Length 

Notes window. 

General notes can be added in the Treatment Length Notes window and can only 

be edited by the party that added them. For instance, the Consultant can not edit a 

note added by the New Zealand Transport Agency (NZTA). Review notes are 

added in the Shortcuts window, as explained in Shortcuts - Working In Review 

Mode (see "Shortcuts" on page 112). 

 

 

 

Ending a Review 

When the review of the Current Programme is complete you tell RAMM that the 

review is at an end by choosing the Actions > Review > Finish menu from the 

Programme Maintenance window in RAMM Manager. 
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Review Report 

You can look at the notes, status and priorities for the Treatment Lengths that are 

not alright using the Review Report. This report is available from the Programme 

Maintenance window in RAMM Manager by choosing the menu Actions > 

Review > Report. 

 

 

The report will look something like this. 

 

 

 

Making the Requested Changes to the Programme 

Making the requested changes is done the same way as developing the programme. 

In the Forward Work window, the Treatments can be moved by dragging and 

dropping them from where they are at present to where the New Zealand 

Transport Agency (NZTA) wants them to be. Treatments can be erased and new 

Treatments added if necessary. 
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Review Status 

The status is changed automatically as the programme is edited. 

When the status of all the Treatment Lengths is OK the programme can be 

submitted to the annual plan. 

Step in Process Review Status 

Consultant constructs the Forward Work Programme Proposed 

NZ Transport Agency reviews Treatment Lengths  

No changes required OK 

Changes required Please Revise 

Consultant makes requested changes Changed 

NZ Transport Agency reviews again  

No changes required OK. 

Changes required Please Revise 

 

 

Forward Work Programme Costs 

The cost of a Treatment Length for each year of the Twenty-Year Programme is 

calculated using the routine maintenance costs from the RMCE curve, the 

overhead cost of the Cost Set, the cost of the Treatment and the costs of any MIS 

attached to the Treatment. The latter two are used only if there is a Treatment 

scheduled.  

• The routine maintenance cost of the pavement and the surfacing is interpolated from 

an RMCE curve set against each Cost Set. 

• If there are Treatments present with an MIS attached, these MIS costs override the 

cost from the RMCE curve. 

• A Cost Set is attached to each Treatment Length. 

• The cost of a Treatment is attached to a Cost Set. 

• The cost of an MIS is attached to each Cost Set. 
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Setting Up To Calculate Costs 

The following must be done to enable the estimation of routine maintenance 

costs: 

• The Treatment costs for each Cost Set need to be entered. 

• The MIS and MIS costs for each Cost Set need to be entered. 

• The MIS for the year before and the year of Treatment needs to be entered against 

each Treatment.  

• RMCE curve(s) need to be defined and attached to the Cost Set(s). 

• Overhead costs for cyclic maintenance such as litter removal and grass mowing need to 

be entered for each Cost Set. 

• The reset of the RMCE curve needs to be defined for each Treatment. 

Maintaining Treatments, Treatment Length Cost Sets and Maintenance 

Intervention Strategies are discussed earlier in this document in the Preparing for 

Forward Work Planning section. 

 

Routine Maintenance Cost Estimation 

The RMCE curves are derived curves for a Cost Set. They predict maintenance 

costs for any number of years into the future for all Treatment Lengths within that 

Cost Set. The curves can be produced by analysis of historical pavement and 

surfacing costs by seal age.  

There is a default curve in the database to provide a starting point, but Consultants 

will define their own curves as they analyse their region maintenance costs and 

work out curves that best reflect their area. How far forward the curve estimates 

costs will reflect the areas maintenance costs. If a large cost, such as one greater 

than $100,000/km/year, is being incurred, then the curve may need to extend to a 

longer time frame than ten or twenty years to accommodate the initial position on 

the curve, calculated from previous years maintenance costs. 

RMCE Curves are defined and maintained by Consultants. However, the 

information is retained in the database by means of the Forward Work Unload and 

Load that transfers it to the main databases held at the New Zealand Transport 

Agency. 

 

Maintaining RMCE Curves 

RMCE Curve definitions are maintained in RAMM Manager. Access the 

maintenance window from the menu Projects > Forward Work > Routine 

Maintenance Cost Estimation. 
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You need to define RMCE Curves for each of the Cost Sets that you have in the 

Security Zone. This is because the profile for different areas of the network may 

not be the same as each other. 

 

Duplicate Curve For Other TL Cost Sets 

If you wish to copy one RMCE Curve definition to another Cost Set then you can 

do so using the Duplicate Curve for other TL Cost Sets button. 

This displays the following that allows you to choose one or more of your other 

Cost Sets to copy the curve. 

 

 

Select one or more of the Cost Sets and click on OK to copy the RMCE Curve. 

Once the points on the curve have been defined, the curve is attached to a Cost 

Set. This is done via the RMCE tab on the Cost Set maintenance window. 



 

1 2 0  F o r w a r d  W o r k  P r o g r a m m e  
 

 

 

You need to choose from the list of RMCE Curves that are available for the 

highlighted Cost Set. 

If you have a standard Overhead charge that is to always be added to the RMCE 

cost at any point then enter a value here. 

 

Overhead Costs 

The figure in the Overhead box is to cover items that are not in the Pavement or 

Surfacing maintenance categories, such as litter removal, verge mowing and 

vegetation control. This is independent of the age of the seal and is added onto the 

routine pavement and surfacing maintenance cost interpolated from the RMCE 

curve to get the total maintenance cost. 

 

RMCE Curve Reset after Treatment 

The Reset RMCE Curve drop-down menu contains three options - None, Reset to 

Midpoint and Reset to Zero. This defines what change occurs to the maintenance 

costs in the year following the treatment. 

The way that costs are calculated for the year after the treatment depends on the 

setting for the Reset. 

 

None 

The curve continues on as it was. For example, if the year two years before the 

treatment was Year 5 of the curve, a Maintenance Intervention Strategy was 

applied to the next two years and the treatment did not reset the curve. The year 

after the treatment would then be Year 8 of the curve. 
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Midpoint 

The year the curve would have been on in the year of the treatment minus the life 

of the treatment as defined in the Treatments table, or zero which ever is greater. 

This is not actually the Midpoint of the RMCE curve, but it is more the midpoint 

of where the curve was before the treatment occurred with some adjustment for 

the expected life of the treatment. 

 

Zero 

The cost at Year 0 of the curve is applied to the year after the treatment.  

The graphs and tables below show the effects of the resets. They are based on the 

curve being on year three in 1998/99, with a Reseal with a five-year life ($30,000) 

in 2002/03, an MIS of Pre-reseal repairs ($20,000) in the year before the treatment, 

an MIS of Normal maintenance ($5,000) in the year of the treatment and an 

overhead cost of $1,000. Values of the curve are tabulated below. 
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Calculation of Programme Costs 

There are two places where you can calculate the Forward Work Programme costs 

for both Treatments and Routine Maintenance. They are the Forward Work 

Balancing window or the Status Check Dialog. 
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Calculating from Status Check 

Access Status Check from RAMM Manager using the menu Processes > Status 

Check. 

 

 

Choose the Forward Work Cost tasks and Calculate Forward Work Costs. 

If RAMM knows that the Forward Work Costs are out of date then this item will 

already be ticked. 

Once you begin processing you will see the following dialog asking you if you 

wish to calculate the costs for all Forward Work Programmes in the database or 

only those that are flagged as needing to be updated. 

 

 

Choose either option and you will see a process dialog similar to the following. 

 

 

One of these dialogs will be displayed for each of the Forward Work Programmes 

where the costs are being calculated. As you can see this process will calculate the 

Treatment Costs followed by the Routine Maintenance Cost Estimates. 
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Calculating from Balancing 

Open the Forward Work Balancing window and choose the menu Actions > 

Calculate to start the process running. 

This will then run the same processes as described above to calculate the 

Treatment and Routine Maintenance costs. 

 

Looking at the Treatment History 

When an End of Year Rollover has occurred any work that was planned in Year 1 

will be moved into the Treatment History. 

If you wish to see what Treatments have taken place in the past you can do so by 

referring to the Treatment Length. The Treatment History tab is available on the 

Treatment Length Detail window in RAMM. 

 

 

Any historical Treatment that took place on the Road and whose location falls 

wholly or partially within the Treatment Length displacements, will be shown 

here. 
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A Lookup is a set of column values which is selectable from drop-down lists in 

 screens.  

Maintenance of look up tables is available in RAMM Manager. Some look up 

tables are nationally controlled and the balance require some liaison with the New 

Zealand Transport Agency Regional staff before adding, changing or deleting 

entries. The data relationship between these tables is complex and care should be 

taken when maintaining them. 
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Preparing for Forward Work Planning 

This section details what you need to do before you can set up and maintain a 

Forward Work Plan. We will look at creating an empty plan, setting up 

Treatments, Reasons and other supporting information. 

 

Twenty-Year Programme 

The Forward Work Programme summarises maintenance and improvement 

treatments for all Treatment Lengths. The programme is prepared for the 

subsequent 20-year period. 

Controlling network management at project level is a continuous process. 

Constant assessment, reassessment and adjustment of treatments, Treatment 

Lengths and Maintenance Intervention Strategies are required. 

Pavement Maintenance Management is a dynamic process. As the pavement ages, 

deterioration will occur in different ways and at different rates. Continual 

assessment of the appropriateness and success of programmes and strategies will 

lead to quality decisions being made for future programmes and strategies. 

The alignment of understanding between Client, Consultant and Contractor 

should result in feedback being provided from all these parties. 

 

National and Local Lookup Tables 

Maintenance of look up tables is available in RAMM Manager. Some look up 

tables are nationally controlled and the balance require some liaison with the New 

Zealand Transport Agency Regional staff before adding, changing or deleting 

entries. The data relationship between these tables is complex and care should be 

taken when maintaining them. 
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Nationally Controlled Information 

Information in these tables is maintained by the New Zealand Transport Agency 

(NZTA) at Head Office. If you want to update or add to any of this information, 

please contact NZTA at your Regional Office and they will approach Head Office 

with your request. Updated national tables, for your Network Management Area, 

can be unloaded from the main database at Head Office, using National Table 

Export. When you receive the file you can load it into your regional database using 

the National Table Import. 

Nationally controlled information includes: 

• Funding Groups 

• Maintenance Intervention Strategies (excluding costs) 

• Note Types 

• Primary Motivators 

• Reasons 

• MARG Factors 

• MARG Weightings 

• MARG Activity/Defect Relationships 

• Safety Intervention Strategies 

• Treatments (excluding costs) 

• Treatment Groups. 

 

Locally Controlled Information 

The following information must be developed locally to suit the needs of the 

Network Management Area: 

• Treatment Length Cost Sets 

• Treatment Costs 

• Maintenance Intervention Strategy Costs 

• Routine Maintenance Cost Estimation. 

Having established the tables, the Treatment Length - Cost Set link must be 

established locally and the treatment costs for each Cost Set generated. Cost Sets 

operate in a similar manner to the Cost Sets that we are familiar with in the 

RAMM Treatment Selection Algorithm (TSA). 

Locally entered data are transferred back to the New Zealand Transport Agency 

(NZTA), for input into the main database, using the Forward Work Unload/Load 

processes.  
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Funding Groups 

Funding Groups represent a generic grouping of treatments into items under 

which funds will be sought. Grouping will be established on the basis of the 

criteria established in the Programme and Funding Manual. 

 

Maintaining Funding Groups 

Access the maintenance window from RAMM Manager using the menu Projects 

> Forward Work > Funding Groups. 

 

 

Funding Groups can only be maintained if you are logged in to the Entire 

Network Security Zone. Contact the New Zealand Transport Agency (NZTA) if 

you want to add or update any Funding Groups. 

Updated Funding Group information can be delivered to the Consultant using the 

National Table Export/Import. 

 

Treatment Groups 

Treatment groups are established for network management purposes. 
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Maintaining Treatment Groups 

Access the maintenance window from RAMM Manager using the option Projects 

> Forward Work > Treatment Groups. 

 

Treatment Groups can only be maintained if you are logged in to the Entire 

Network Security Zone. Contact the New Zealand Transport Agency (NZTA) if 

you want to add or update any Treatment Groups. 

Updated Treatment Group information can be delivered to the Consultant using 

the National Table Export/Import. 

Some areas of Forward Work Planning need to know which Treatments indicate 

Reseal work. To do this a flag is set against only one of the Treatment Groups to 

indicate that all the Treatments that are part of this Group are Reseal.  

Setting this flag for one of the Treatment Groups will automatically cause all other 

Groups to have the flag set to Not Reseals. 

The MARG Priority Index is used to indicate whether or not Treatments 

belonging to this Group contribute to the Reseal Index or Pavement Area 

Treatment Index. 

 

Treatments 

Forward Work Programme Treatments are simply descriptors of the type of work 

to be carried out in order to maintain a length of Network - a Treatment Length. 

In the Forward Work Programme we use a cell to indicate each of the Planning 

Years for a Treatment Length. If the cell is left blank with no Treatment assigned, 

then we assume that only Routine Maintenance is taking place at that location.  
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When we calculate the cost of maintaining a Treatment Length in a given cell 

(Financial Year) we need to take into account a number of factors. For instance, 

the last Treatment to take place and the Routine Maintenance costs in the last year 

need to be considered. 

We may not need to apply the selected Treatment to the entire Treatment Length. 

So it is possible to indicate that a Treatment is to be applied to a percentage of the 

Treatment Length. 

This coverage percentage is used when calculating the cost of a Treatment. 

Percentage coverage can be set to apply to all Treatments but it is principally 

intended for work such as drainage improvement which would normally apply to 

only a part of the Treatment Length.  

When defining a new Treatment you can indicate whether to allow a Percentage 

Coverage by setting the appropriate flag. 

Treatments are defined nationally by the New Zealand Transport Agency 

(NZTA) who have control over this Master List. Consultants can have access to 

new or updated Definitions by either selecting them from the Master List or using 

the National Table Export/Import (see "National Tables Export" on page 170). 

 

Treatment Applicability 

Not all Treatments are available for use in the Forward Work Plan in any given 

Planning Year. The more general the Treatment definition the further out in the 

Programme you would use it. 

All Treatments defined in Forward Work Planning are assigned to one of the 

following Programme Periods: 

• Years 1 to 4. 

• Years 1 to 10. 

• Years 1 to 20. 

• Years 3 to 10. 

• Years 11 to 20. 

Over time, processes such as the End of Year Rollover (on page 162) may cause 

some Treatments to move from a Year where they are valid to one where they are 

not. RAMM provides a report to allow you to quickly find these cases so that you 

can replace the Treatment with one more applicable to the Planning Year. 
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Treatment Life 

Each Treatment is expected to be effective for a limited period of time. This 

Treatment Life may vary between the different parts of your network. A Suggested 

Life is provided for each Treatment. This is defined by the New Zealand 

Transport Agency (NZTA). However, since the Life of the Treatment can be 

different in each of the Security Zones, Consultants have the ability to assign their 

own value for the Treatment in their Network Management Area. 

 

Inactive Treatments 

Over time Treatment definitions may change and there will be definitions that 

you no longer wish to be used in your Forward Work Programme. However, they 

may still be recorded in the Treatment History of work that has been completed in 

previous years. 

To ensure the history is retained you can flag Treatments as being Inactive. 

However, this does not automatically mean that those Treatments are removed or 

replaced in the Current or Alternative Programmes. To assist you to find Inactive 

Treatments in your plan RAMM provides an Inactive FWP Treatments Report 

(see "Inactive Treatments Report" on page 81). 

 

dTIMS Treatments 

RAMM Forward Work Planning (FWP) can import information from a dTIMS 

analysis (see "dTIMS Analyses and Forward Work Planning" on page 168) and 

record it as an Alternative Scenario. The definitions for dTIMS Treatments are 

imported and recorded with the FWP Treatments. RAMM then flags all 

Treatments as originating in either FWP or dTIMS. 

 

Maintaining Treatments 

RAMM maintains a Master List of Forward Work Programme Treatments. This 

can be accessed only by someone logged in to the Entire Security Zone. Using 

RAMM Manager, follow the menu path Projects > Forward Work > Treatments. 

Once the screen is displayed you follow the menu path Mode > Master List. 
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You assign new Treatments to Funding and Treatment Groups. You must also 

state for which Programme Period the Treatment is applicable. The default 

Suggested Life for a new Treatment is five years. You can change this. Select the 

Allow Coverage option to allow your new Treatment to apply to a percentage of 

the Treatment Length. If Coverage is not allowed, the Treatment will be assumed 

to apply to 100% of the Treatment Length. To indicate that a Treatment may no 

longer be used in Forward Work Programmes, follow the menu path Actions > 

Active and clear the option. Although the Treatment can no longer be used for 

future work, it may still be recorded in the Treatment History. 

The RAMM report Inactive FWP Treatments (see "Inactive Treatments Report" 

on page 81) can be used to determine where Inactive Treatments are present in the 

Programmes so that they can be replaced with a more appropriate alternative. 

 

Treatment Life 

Treatments may have different lives depending on the local conditions in part of 

the Network in which you are working. 

To handle this, Forward Work Planning allows you to define a different Life for 

the Treatment for each Security Zone in the database. 

When you select a Treatment from the Master List for use in the Security Zone, 

the Treatment Life will default to the Suggested Life from the New Zealand 

Transport Agency (NZTA) 

You can adjust this to suit your local conditions. 

The Treatment Life within the Security Zone is used for calculating which year 

from the RMCE curve will be used after a treatment with a curve reset of Reset to 

Midpoint. 

How it is involved is explained in RMCE Curve Reset after Treatment (on page 

120). 
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The life listed in the treatment table is different from that listed in the surface life 

table because traffic factors have been left out in order to simplify things. 

The calculation would become too complex and time consuming if the balancing 

programme had to take all the traffic volumes on the Treatment Length in order to 

determine the life of the Treatment. 

 

Treatment Costs 

The cost of applying a Treatment will vary between and within Network 

Management Areas (Security Zones) as a result of local conditions. 

RAMM allows you to record the cost for each Treatment for each of the Cost Sets 

that have been defined. 

The section on Treatment Cost Sets (on page 133) has a more detailed explanation 

of their definition and use. 

 

 

 

Treatment Cost Sets 

In the Forward Work Programme, Treatment Cost Sets are synonymous with the 

Cost Sets used in Treatment Selection. They are known by the same name and 

apply over the same area. 

To change the Cost Set with which a particular Treatment Length is associated, 

you edit the Cost Set field on the Treatment Length screen. This change will then 

apply to both Treatment Selection and the Forward Work Programme financial 

calculations. 

Treatment Cost Sets are defined for Security Zones and will only apply within 

them. However, a given Treatment Length can only have one Cost Set associated 

with it. 
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In all cases the Treatment Costs are based on units of $/m
2

. 

 

Maintaining Treatment Cost Sets 

Access Treatment Cost Sets through the RAMM Manager menu Maintenance > 

Lookups > Carriageway > Cost Sets. 

 

 

Cost Sets can be defined either by the New Zealand Transport Agency (NZTA) 

or the Consultant. 

New Cost Sets are automatically numbered according the range allowed for each 

Security Zone. 

If no range is defined for the Security Zone as may apply in a Local Authority 

database, then the Cost Sets will be numbered from one (1). 

When you insert a new Cost Set RAMM will automatically create one row for 

each of the active Treatments that are flagged with an Origin of NOMAD. 

The Unit Cost, which is expressed in $/m
2

, will default to zero (0) and can be 

updated as required. 

This information is the same as that displayed for individual Treatments on the 

Treatment maintenance window and you can edit it from either place. 
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Cost Set Treatment Length 

This window also allows you to define which Cost Set each of the Treatment 

Lengths will use. Although you can assign a Cost Set by maintaining the 

Treatment Length in RAMM, you can also do it here by highlighting one or more 

Treatment Lengths, selecting a Cost Set from the Move to cost set combo box and 

clicking on the Move button. 

 

 

Routine Maintenance Cost Estimation 

If you intend using Routine Maintenance Cost Estimation (RMCE) you will need 

to define an Overhead Cost to the Cost Set and associate it with a RMCE Curve. 
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Additional information on the Detail tab that is used in the RMCE calculation is 

the Maintenance Intervention Strategy which is to be applied to the year in which 

the Treatment takes place and that for the year just previous to the one where the 

Treatment takes place. Maintenance Intervention Strategies (on page 165) have 

costs associated with them and so impact on the RMCE. 

Finally on the Detail tab is a RMCE Reset option. This also has an impact on the 

RMCE calculation and needs to be considered if you wish to use this 

functionality. 

 

 

This table holds all the Treatments that are recognised in the database as well as 

the groups they are in (funding and treatment), their expected life and their unit 

costs by Cost Set.  

The pull-down menus titled MIS (Year of Treatment) and MIS (Year Preceding) 

are where the MIS for the treatment are attached. If an MIS is selected for either of 

these years, the maintenance costs given by the RMCE curve will be overridden 

with the figure defined in the Maintenance Intervention Strategy window for the 

particular Cost Set. For example, if the treatment was a reseal, the MIS for the year 

preceding the reseal may be Pre-Reseal Repairs (to reflect the increased of 

maintenance to bring the Treatment Length to the ideal condition for sealing) and 

the MIS of the year of the Treatment may be normal maintenance (to keep the 

Treatment Length in the same condition).  

The Consultant needs to decide what the MIS (if any) will be for each treatment. 

If it is decided there will be no special maintenance for a Treatment then leave the 

two MIS columns blank. For example, a Treatment such as shoulder grading may 

have no impact on the interpolated costs and accordingly the MIS will be left 

blank. 

 

Maintaining Cost Set Ranges 

The New Zealand Transport Agency (NZTA) defines the range of allowed Cost 

Set Identifier values. Each Security Zone is assigned its own unique range.  
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You maintain Security Zones in RAMM Manager using Maintenance > Security 

Zones. Take care if the Security Zone Cost or Set Number is changed in one 

database and not the other. There may then be problems with the transfer of 

information between the NZTA and Consultants. The Forward Work Load may 

reject the file Unloaded from the other database. If the Cost Set Number Range 

overlaps that assigned to a Security Zone which is not its parent, then the FWP 

Load may overwrite the wrong definition and vital information will be lost. 

 

Reasons 

Reasons are the explanations of why a given Treatment will be carried out when 

maintaining a Treatment Length. One or more reasons must be entered for every 

Planning Year in the first three (3) years, when you assign at least one Treatment. 

 

Maintaining Reasons 

The New Zealand Transport Agency (NZTA) maintains the Master List of 

Reason Definitions. The Master List can be accessed in RAMM Manager by 

following the menu path Projects > Forward Work > Reasons. You will need to be 

logged in to the Entire Security Network Zone and once the screen opens, change 

to the Master List by following the menu path Mode > Master List. 
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When inserting a new Reason Definition you will need to supply the Code and the 

Description.  

Each Reason can have none, one, or more Primary Motivators associated with it. A 

Primary Motivator is a definition of the underlying cause for the Reason when it 

has been assigned to a planned Treatment. For example, you may have assigned a 

Treatment of Reseal to a Treatment Length. The reason may be because of 

Cracking, but the underlying reason for the cracking is a deterioration of 

Pavement Performance. This Pavement Performance is the Primary Motivator. 

You can tell RAMM that you require further details to be entered into the 

Programme when a given Reason is assigned. You do this by selecting Required 

from the Note Required drop-down list. This ensures that RAMM requests a 

Reason Note to be entered whenever this Reason is used. 

When you save a new Reason Definition you will be asked if you wish to add it to 

the Security Zone. 
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Primary Motivators 

The New Zealand Transport Agency (NZTA) maintains the list of Primary 

Motivators. You need to log in to RAMM Manager using the Entire Network 

Security Zone. The Primary Motivator Definitions are accessed by following the 

menu path Projects > Forward Work > Primary Motivator. 

 

 

When entering a new Primary Motivator you will need to supply both a Code and 

Description. You can include some notes if you wish. 
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Note Types 

Note Types are used to categorise the free format notes available for entry against 

the Current Forward Work Programme or any alternative scenario. 

 

Maintaining Note Types 

Note Types are defined by the New Zealand Transport Agency (NZTA).  You 

will need to log in to the Entire Network using RAMM Manager and following 

the menu path Projects > Forward Work > Note Types. Updated Note Types are 

immediately available for use within all Security Zones or can be obtained from 

NZTA by using the National Table Export/Import process. See  National Table 

Export/Import process (see "National Tables Export" on page 170). 

 

 

 

Maintaining Overview Tolerances 

This screen allows you to set up Tolerance Years and a percentage variation for 

each. These are defined by the New Zealand Transport Agency (NZTA). You log 

in to the Entire Network Security Zone using RAMM Manager and follow the 

menu path Projects > Forward Work > Overview Report Tolerances. These 

options control how the Overview Report (on page 103) is generated. 
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Programme Maintenance allows you to manage multiple Forward Work 

Programmes. 
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Managing Programmes 
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Programme Maintenance 

Programme Maintenance allows you to manage multiple Forward Work 

Programmes. When you next use the Forward Work Programme features within 

RAMM for Windows you will be able to choose the Programme to work with. 

Use this window to copy, print and manage your Programmes. 

Programmes can also be transferred into and out of the Master Current 

Programme from here. 

 

Maintaining Forward Work Programme Headers 

The maintenance of Forward Work Programme Headers is carried out in RAMM 

Manager from the menu Projects > Forward Work > Programmes. 

 

 

If you do not have any Forward Work Programmes defined in your database then 

the first time that you enter this window a Current Programme will be 

automatically created for you. By default the name of this Programme will be 

Current Programme but you can change this at any time. 

Apart from the name of the Programme, the Author and the Notes nothing else 

on this window can be changed by directly editing the field on the window. All 

changes and other maintenance functions are accessed from the Actions or Reports 

menus. 
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First Year 

The First Year indicates the Financial Year corresponding to Year 1 of the Forward 

Work Programme. Year 1 is the Current Financial Year and any work planned for 

that year should have been approved and already be taking place. The First Year 

changes only when you perform an End of Year Rollover on the database. This is a 

New Zealand Transport Agency (NZTA) function that is described more fully in 

our section on End of Year Rollover (on page 162). 

 

Lock Mode 

The Lock Mode is an indication of the state of the Programme. It can be 

Programmable, which means that you can maintain full details of the Programme, 

Locked, which means that you can not change the Programme, or Review only, 

which means that the Programme has been created as a copy of the Current 

Programme for use during the Review. See the section on the Reviewing the 

Forward Work Programme (on page 106) for more details. As a Consultant, any 

changes that you make to a Programme that you have unlocked may be lost when 

the New Zealand Transport Agency (NZTA) returns a copy of the database to 

you. 

 

Format 

The Format of the Programme can be Current, Archived, Linked, or dTIMS 

Recommendation. Only one Programme can be the Current Programme. Copies 

of the Current or other Programmes are set with a Format of Linked. If you 

choose to Archive a Programme then the Format will be set to Archived. Archive 

Programmes retain only their cost information. All other information will be lost. 

Only Programmes that have been loaded from dTIMS Analysis data will have the 

Format of dTIMS Recommendation. 

 

dTIMS Analysis Date 

The dTIMS Analysis Date is information that is loaded from the dTIMS Analysis 

and indicates the date when that analysis was carried out in dTIMS. It is not the 

date when you loaded the analysis into RAMM but the date, from dTIMS, when 

the analysis was carried out. 
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Actions > Duplicate 

This option will create a copy of the highlighted Programme. By default the new 

copy will have the same title as the original with the text "Copy of" prefixed. You 

can rename it to suit yourself. 

This programme will also be given the Format of Linked to indicate that it is not 

the Current Programme, but is derived from it. 

 

Actions > Lock/Unlock Programme 

Use this menu to either lock a Programme that is Unlocked or to unlock a 

previously Locked Programme. You can lock a Programme yourself if you wish to 

ensure that you do not accidentally change any of the details. If you unload a 

Programme using the Forward Work Unload/Load it will automatically be locked. 

You can still unlock an unloaded Programme but you will be warned that any 

changes you make may be lost if the Programme is returned. Returning a 

Programme through the FWP Load will also unlock it. 

 

Actions > Make Current 

Use this option to set the highlighted Programme to be the Current Programme. 

Remember, that only one Programme can be Current at any one time, so setting 

the highlighted Programme to Current will cause the former Current Programme 

to be set as Linked. This is not available for Archived Programmes or those loaded 

from a dTIMS Analysis. 

 

Actions > Review 

These options are used when reviewing a Programme. See the section on the 

Reviewing the Forward Work Programme (on page 106). 

 

Actions > Acquire Master Current Programme 

When you log in to a Security Zone other than the Entire Network, you will have 

your own Current Forward Work Programme. You maintain this Programme for 

the Treatment Lengths in your part of the Network. You use this option to take a 

copy of that part of the Master Current Programme associated with your portion 

of the Network and put it into your Current Programme. You can simply over 

write your Current Programme or take a copy of it first. 
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Actions > Add to Master Current Programmes 

During the course of the year a Consultant will be maintaining the Current 

Forward Work Programme associated with their Network Management Area or 

Security Zone. At certain times of the year the New Zealand Transport Agency 

(NZTA) will require the latest version of the Consultant's Programme to be added 

into the Current Master Programme. 

This is a two step process. When you are logged in to a Security Zone other than 

the Entire Network, you highlight the Current Programme and select this option. 

A flag will be set which notifies NZTA that the Programme is ready to be 

transferred. 

NZTA logs in to the RAMM Manager using the Entire Network Security Zone. 

This will give access to the Master Current Programme. Highlight the Programme 

and access the Save option. Any Programmes which are ready to be transferred 

will be listed and you can bring them in to the Master Current Programme. 

 

Actions > Set FW Treatment on Surf/Pavement 

Surfacing and Pavement Layer data can be associated with the corresponding 

Forward Work Programme Treatment. This process takes this information from 

year one (1) of the Current Forward Work Programme and, where possible, 

populates the Treatment to the Surfacing and Pavement Layer records. The 

Forward Work Treatment History will also be checked to see if any previous 

surfacing or Pavement data can also be updated. 

 

Reports > Detail Report 

This is another way to access the Forward Work Detail Report. Please see Forward 

Work Detail Report (on page 96) for more information. 

 

Reports > Review 

This option is used when reviewing a Programme. Please see the section on 

Reviewing the Forward Work Programme (on page 106). 
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Deleting a Forward Work Programme 

You can not delete the Current Forward Work Programme in RAMM. If you 

genuinely wish to delete the Programme you are currently working on, you must 

first set one of your Alternative Scenarios to be the Current Programme. You will 

then be able to delete the one which was the Current Programme. 

If the Programme you are deleting is a copy of the Current Programme, then you 

will be prompted to confirm the deletion but having done that the Programme 

will be deleted. 

However, if the Programme that you intend deleting is one created as part of a 

Review of the Current Programme then you will see the following dialog 

displayed. 

 

 

You can then choose to keep the Review Notes from the Programme you are 

deleting or to remove those as well. 

 

Programme Development 

The Twenty-Year Programme produced by the intellectual process is an indicative 

assessment. 

Rehabilitation and improvement works identified are then subject to more 

rigorous economic and engineering scrutiny. 

Once funding levels are confirmed, the Twenty-Year Programme will be reviewed 

to ensure rejected proposals have appropriate Maintenance Intervention Strategies 

applied. 

 

Preparing the Forward Work Programme 

The site assessment should identify possible solutions. 

These need to be costed and quantified against economic criteria or by economic 

awareness to determine the most economically acceptable solution. 



 

 C h a p t e r  1 3   –   M a n a g i n g  P r o g r a m m e s  1 4 7   

A priority will need to be allocated against each treatment. 

Treatments may be determined by referencing other sources of information. This 

may include safety improvements or other improvement works separately 

investigated. 

The status, timing and economic viability of these projects will need to be 

determined and recognised prior to inclusion in the Twenty-Year Programme and 

allocation of a Maintenance Intervention Strategy. 

 

Maintenance Functions 

Maintenance of the Twenty-Year Programme and supporting files will generally 

follow the following pattern. 

1 Maintain look up tables. 

2 Review treatments. 

3 Review and maintain Cost Sets. 

4 Review Maintenance Intervention Strategies. 

5 Review Safety Intervention Strategies. 

6 Review intervention levels for the exception reporting. 

7 Run exception reports (Treatment Lengths generating an exception in condition data 

will be flagged). 

8 Review treatments - office exercise. Use the exceptions generated and/or associated 

condition data. 

9 Review treatments - field review. 

 

Performance Monitoring 

The constant evaluation of the degree of success of selected treatments will enable 

greater confidence to be provided to future treatment selection evaluations. 

Performance monitoring and the associated feedback is critical to the development 

of the intellectual process. 

 

Assessing Your Data 

Prior to any field assessment of Treatment Lengths being made, data needs to be 

collated and interpreted to determine the trends and exceptions described in 

Trends and Exceptions (on page 90). 
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Importance 

The bulk of maintenance expenditure is likely to occur over a small percentage of 

the network. When cumulative expenditure is plotted against cumulative length, 

65% of expenditure occurs over 20% of the length of the network. 

Data collection and analysis will allow the 20% of the network with high 

maintenance costs to be more readily identified and Treatments and Maintenance 

Intervention Strategies formulated to reduce maintenance costs. An improvement 

in maintenance programmes and strategies will result in a trend towards a straight 

line (even) distribution of needs. 

 

Assessing the Programme in the Field 

Treatment Lengths that have trends and exceptions noted are targeted for field 

assessment. The field assessment will require visual inspection of the site to 

determine: 

• Is there is a problem as indicated by the trend or exceptions? 

• Is there is any other problem associated with the site? 

• What is the cause of the identified problem? 

• What is the extent of the problem?  

• Is local or area treatment appropriate? 

• What are acceptable solutions? 

 

Unloading Programmes 

Use the Forward Work Unload function to unload a selection of programmes to 

be delivered to the New Zealand Transport Agency (NZTA).  

 

Programmes 

Programmes to be unloaded can be chosen from a list containing all programmes 

in the database. Programmes changed or created since the database was 

downloaded are automatically checked. The Current Programme is automatically 

included in the programmes to unload and can not be unchecked.  

WARNING: Any changed programmes that are not sent will not appear in 

the next database downloaded by the Consultant. 
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Unload 

During the unload, the status of treatments is switched from Changed to Proposed 

for each chosen programme and the programmes Locked. 

The programmes are locked to prevent changes being made until a new database is 

downloaded by the Consultant. 

Programmes downloaded from the New Zealand Transport Agency (NZTA) are 

always Unlocked. 

To unlock a programme yourself and continue working with it, use the Projects > 

Forward Work > Programmes menu option in RAMM Manager. 

If you do this you must ensure another Unload is sent before you next download a 

database from NZTA or your work will be lost. 

 

Save as type 

All data for the chosen programmes is unloaded to a single compressed file with an 

.FWU extension. 

 

Email 

The .fwu file created can be emailed to the New Zealand Transport Agency 

(NZTA) for loading into their programme. 

 

Programme Unload (NZ Transport Agency/Consultant) 

After giving RAMM Manager exclusive access to the database, you choose Projects 

> Forward Work > Unload. The Status on the unloaded programmes changes to 

locked when either user unloads. The status automatically changes to locked to 

prevent any changes being made while the other party has the programme, as these 

changes will be lost if they are not unloaded before the programme received from 

the other party is loaded. The programme can be unlocked in RAMM Manager 

using the menu Projects > Forward Work > Programmes, select the programme, 

then Actions > Unlock Programme. 
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Choose the destination directory and the name for the Unload file and press 

Unload. 

 

 

Press Close and the file is ready to be sent to the New Zealand Transport Agency 

(NZTA). 

 

Loading Programmes 

The Programme Load wizard is used to load Programmes, sent by Consultants, 

into the New Zealand Transport Agency (NZTA) database. This simplifies 

choices on which programmes to load, whether or not to create a copy of the 

programmes being overwritten and managing alternative scenarios. The contents 

of the load file are displayed and the programmes to be loaded are offered.  

 

Loading Implementation Steps 

The following implementation steps are carried out by the New Zealand 

Transport Agency (NZTA) before unloading the database for dispatch to 

Consultants. 

►  Load ing  Imp le men ta t i on  S teps  

1 Maintain nationally controlled lookup tables (see "National and Local Lookup Tables" 

on page 126). 
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2 Summarise Treatment Lengths. This process summarises key data to the Treatment 

Length level. For example, roughness statistics (mean, maximum, etc). The database 

will then be unloaded and released. Implementation should then continue as below. 

3 Complete lookup table creation - Regionally controlled tables. (Liaison with Regional 

NZTA Staff is essential) 

4 Maintain Treatment Lengths. Maintain the system generated Treatment Lengths to 

match the physical layout appropriate. The Generate Treatment Length process will 

create Treatment Length joints at all Major Seal Joints. These may not match the joints 

considered appropriate locally. 

5 Maintain the Cost Sets attached to the Treatment Lengths. The generate function 

defaults these to the same Cost Sets currently attached for treatment selection. If these 

are not adequately set up to reflect changes in costs associated with area treatments, 

maintenance will be required. 

6 Attach Treatments, Reasons, Maintenance Intervention Strategies, Safety 

Interventions, Priority and Notes to the Treatment Lengths.  

7 Check for the appropriateness of the balance of the programme. This step involves 

consideration of the total length and cost of the various treatments across the twenty 

year planning period: essentially, looking for peaks and ensuring that they are justified. 

Some re-evaluation of treatments may be required to achieve an appropriate balance. 

The programme is then ready for downloading and returning to NZTA. 

 

To Load Programmes 

►  How To  Load  Programme s :  

1 Create a backup of the database. Use the database backup facilities in RAMM Manager 

(File > Backup Database) to create a backup of your database. 

2 Select a Forward Work Archive. Select the forward work archive file (.fwu file 

extension) sent from the consultant. 

3 After selecting the archive, use the load wizard to select load options. Up to three 

windows are presented: 

• Programme Contents - shows the programmes being delivered and the contract areas 

covered. 

• Treatment Lengths have Changed - only shown if the consultant has changed 

Treatment Lengths. 

• Programmes Under Review - only displayed if programmes are being reviewed. 

Once the load routine is completed, the database into which the load was 

performed has an exact copy of the Treatment Lengths and programme 

information unloaded from the consultant's database. 
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Load Programme Contents 

All programmes in your database are displayed in this panel plus new ones created 

by the consultant. Columns are used as follows: 

• Current 

This shows the Current Programme on your database.  

• Received 

this is ticked for all programmes changed and returned by the consultant or shows 

New for all new programmes 

• Copy 

Tick any programmes being returned if you want a copy saved before loading the 

consultant's version. The copy can be viewed and maintained just like other alternative 

or scenario programmes. 

 

Loading Changed Treatment Lengths 

This window is displayed because the Treatment Lengths in the database are 

different from those delivered from the consultant. The new or changed 

Treatment Lengths from the consultant will be loaded, replacing any Treatment 

Lengths covering the same carriageway length. Only Treatment Lengths for the 

contract areas being loaded are changed. 

The Treatments in alternative scenario programmes covering these Treatment 

Lengths will be cleared. If a new programme has not been delivered by the 

consultant, there are two options for how to deal with these Treatment Lengths 

that have no forward work programme: 

• Blanks - leave the programme blank. 

• Current - schedule the same treatments scheduled in the Current Programme. 

 

Loading Under Review 

This window shows programmes currently in Review. If a programme is received 

while a review is under way you must decide whether to delete the review and 

restart from scratch or continue with the review. If you choose to continue you 

may have already made comments about Treatments that the consultant has now 

changed. The comments may be irrelevant and at worst confusing. 
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Invalid Load 

When there are rows that do not link to roads or carriageway sections these are 

listed in a grid and you may fix the errors. The only rows displayed are those that 

are in error. A filter option is available if you wish to further refine the rows 

displayed. You can only update or delete rows. On completion the validation is 

run again either until there are no problems with the data or you press Cancel. 

Two buttons are available to make corrections easier.  

• Correct Carriageways  

• Correct Roads  

These buttons are designed to handle the majority of the cases, however there a 

number of more complex changes that can not be handled by routines (for 

instance Splitting a Road will involve redefining the start and end displacements, 

not just attaching to a new road and carriageway section). You can either make 

these changes manually or return the data and a list of changes that have occurred 

to the roadnames and carriageway table to the data supplier for correction. 

The filter button enables you to filter the information. When a filter is currently in 

use the word Filtered appears on the window title bar. 

 

Correct Carriageway 

The Correct Carriageways button will appear if there are records located within 

the wrong carriageway sections. This button will automatically locate these records 

and place them in the correct carriageway section. If there are two displacement 

columns in the table (for example start_m and end_m) then you must choose which 

one is used to determine the correct carriageway section. When a row does not sit 

within a carriageway section the column carrway_start_m is left as it is. 

 

Correct Roads 

The Correct Roads button will appear if there are records that do not link to the 

roadnames table. The Road ID of the current row is defaulted into the Invalid 

Road ID column. You can either enter the correct Road ID directly into the 

Correct Road ID column or select the roadnames from the pull down list available 

on the Correct Road column. Clicking the Correct button will apply the change. 

 

Programme Load (NZ Transport Agency/Consultant) 

After giving RAMM Manager exclusive access to the database, you should choose 

Projects > Forward Work > Load.  
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The status of the loaded programme changes to Unlocked and Editable for a 

Consultant user and Unlocked but Not Editable for a New Zealand Transport 

Agency (NZTA) user. 

There will be a Forward Work Programme that is the Current Programme. This 

may not necessarily be named Current in the database. The programme that is 

being loaded will overwrite this programme. Therefore, the option to make a copy 

of the existing Current Programme is given to you. By default the name of this 

copy will be the same as the original but with the text "Copy of" prefixed. It is 

recommended that this be renamed if it is going to be retained, to reduce 

confusion later in the year when there may be many programmes with the same 

name. This can be done in RAMM Manager from the menu Projects > Forward 

Work > Programmes, select the programme and type the new name in the box at 

the top right. 

Select the file to be loaded by browsing. 

 

 

When you have selected the file to be loaded click on the Open button and you 

will see the following information. 
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You are warned that by loading this file you may well cause Treatment Lengths to 

be changed in your database. As part of the preparation of the Forward Work 

Programme your Consultant may have changed the Treatment Lengths in their 

Network Management Area. These changes will be implemented in the NZTA 

copy of the database as the Programme is loaded. 

It is recommended, in case there is a problem, that you take a backup either by 

backing up the entire database or by unloading your own copy of the Forward 

Work Programme before loading the one from the Consultant. Your unloaded 

copy will have a record of the Treatment Lengths as they are before the 

Consultant's Programme changes them and you can use this to restore the 

database back to where it was before. 

The Programme Contents part of this window displays details of the Network 

Management Area(s) and Programme(s) that are present in the unload file. Use 

this information to confirm that you have the correct information before 

continuing with the load. 

The Programmes listed on this window include all those currently in your 

database plus an indication of whether you are receiving a new copy of that 

Programme from your Consultant. 

Finally, you can indicate if you wish to make a copy of any one of your existing 

Programmes before the incoming one replaces it. 

Once you have made your choices click on the Next button to continue. 

You then need to decide what you want to do to Programmes (other than the 

Current Programme) when Treatment Lengths have changed. 

For the affected Treatment Lengths you can choose an Action to set those 

Programmes to be Blank, Archived, or to take the Treatment from the incoming 

Current Programme. 
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When NZTA loads the programme from the Consultant after the first review has 

been conducted, they will be asked if they want to carry on the review or abort it 

(default).  

Click on the Next button to see details of the Programme that is under review and 

to decide whether to continue with the review or not. 

 

 

Once you have made your decisions on whether to Abort or Continue the Review, 

click on the Finish button to load the information from the Unload file. 
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When this process has completed the new Forward Work Programmes will be 

available to work with. 

If RAMM encounters a problem during the load process it will abort the process 

and restore the original Forward Work Programmes and Treatment Lengths. 

 

Loaded Programme Report 

A record is kept of all the Forward Work Programme loads that have taken place. 

In addition to recording all the unload and load activity, each time you acquire a 

copy of the Master Current Programme or transfer the Consultant's Current 

Programme into the Master, an entry will be made into the log. 

If you wish to review that history a report is available in RAMM Manager from the 

menu Reports > Forward Work > Loaded Programme Report. 

 

 

You can filter the information passed to the report by selecting a specific Network 

Management Area or by setting the dates that you are interested in. 

The finished report will look something like this. 
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This chapter deals with the creation of the Consultant databases and how 

Consultants import them. 

It also addresses the End of Year Rollover and its effects, the tasks to be performed, 

treatments and intervention strategies. 

It also addresses dTIMS CT and Forward Work Programmes. 
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End of Year Rollover ................................................................. 162 
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Creating a Database for your Consultant 

As part of the planning cycle, the New Zealand Transport Agency (NZTA) will 

create extracts of the main database for each of the Network Management Areas. 

These extracts will be sent to their Consultants. 

This section deals with the creation of the Consultant databases and how 

Consultants import them. 

 

Database Export 

You can export all or part of your Network using the Database Export function 

that is available in RAMM Manager from the menu File > Database Export. 

 

 

Go to the Network tab to choose the portion of your Network that you wish to 

export. The New Zealand Transport Agency (NZTA) returning a Network 

Management Area (NMA) to the Consultant, should use this tab to select the 

appropriate NMA by choosing the appropriate Security Zone. 
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If you wish to exclude a portion of the information in the database you can do so 

by choosing some of the systems listed on the RAMM System tab. 

 

 

When you have finished making your selections, click on the OK button to start 

the export. 

 

Database Import 

When a Consultant receives a database from the New Zealand Transport Agency 

(NZTA) it can be used to create a new database using the Database Import. This is 

available in RAMM Manager from the menu File > Database Import. 

Use the browse window to locate the database export file. 
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Select your file and click on Open to begin the import. 

 

It is advisable to choose to create a new database from this file rather than 

replacing any existing copy. 

 

End of Year Rollover 

The End of Year Rollover process can only be run by the New Zealand Transport 

Agency (NZTA) by logging in to the Entire Network Security Zone. 

Run this rollover process to set up your database ready for planning treatments for 

the next season.  

 

Tasks Performed 

The rollover process performs the following tasks: 
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• Rollover 

The year displayed in the first column of the programme is moved forward one year. 

For example, if 2002/03 used to be the first year, after rollover 2003/04 will show as the 

first year.  

• History 

Treatments scheduled for Year 1, prior to the rollover, are recorded in a history table. 

These can be viewed from the RAMM Treatment Length detail window. 

• Delete Year 1 

 Reasons, reason notes, priority, targets and status for Year 1 are deleted. 

• Maintenance Intervention Strategy Reset 

If the treatments now placed in Year 1 or Year 2 of the programme have changed, the 

MIS is reset to null.  

• Force Balancing Window Recalculation 

When a programme is next displayed in the Balancing window the system will 

recalculate the programme costs. 

 

End of Year Rollover Preparation 

To prepare for running the rollover check the following: 

• Confirm Compatibility will be Maintained 

When unloading and loading programmes, the first year of the loaded programmes 

must be the same as the programmes in the target database. If there is any mismatch 

the load will abort. Be sure that other users from whom you may wish to load 

programmes, or to whom you may wish to send programmes, are using the same year. 

• Backup 

End of Year Rollover makes major changes to the database that are not reversible. 

Create a backup of the database. Use the Database Backup facility in RAMM Manager 

to make a copy of your database before performing the End of Year Rollover. 

• Check Safety Intervention Strategies (SIS) 

Some Safety Intervention Strategies may now be able to be cleared. This is not done 

automatically during the rollover since some Safety Intervention Strategies must 

remain after treatment work is completed. An example of this is where the SIS may be 

long term or not corrected by the programmed treatment. 

 

It is easiest to review the SIS prior to rollover, using the Forward Work Programme 

window in RAMM. This shows the Treatments in Year 1 and allows SIS 

maintenance. The SIS review can be done after the rollover, using the Treatment 

History tab of the Treatment Length detail window and the Forward Work Programme 

window. 

• Check Treatments in Year 1 

 Is the correct programme selected as the Current Programme? It is assumed all 

treatments in Year 1 of the Current Programme have been contracted and completed. 

Check that Year 1 of the Current Programme accurately reflects the work done, as this 

will be recorded in the Treatment History. 
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Performing the End of Year Rollover 

The End of Year Rollover process is only available to the New Zealand Transport 

Agency (NZTA) when using the NZTA master database. You can access this 

function from RAMM Manager using the menu Projects > Forward Work > EOY 

Rollover. 

 

 

The most important thing to note about the End of Year Rollover process is that it 

is irreversible. Once this process has run there is no going back. The only way to 

get back to the position you were in before is to restore a database backup. 

The End of Year Rollover is used to tell RAMM that we are now in a new financial 

year. All Treatments currently defined as taking place in Year 1 are now assumed 

to have taken place. Therefore, this information is moved from Year 1 into the 

History. 

The only information that goes into the History is the Treatment and where on 

the network it took place - the Road and the Displacement. The formal link 

between the Treatment and a Treatment Length is broken at this point. This is 

because Treatment Lengths are dynamic in RAMM and may change considerably 

over time. However, the Road definition is not so volatile and can be used to 

record the location of historical Treatments. 

Information about the Reason, Primary Motivator, Reason Notes and other data 

will be lost. 

Once Year 1 information has been placed into the history all the other Years move 

one forward. That is Year 2 becomes Year 1, Year 3 becomes Year 2 and so on. A 

new, blank year is made available for Year 20. 
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Effects of End of Year Rollover 

This movement of Treatments has some side effects of which you also need to be 

aware. 

 

Maintenance Intervention Strategies 

Part of the normal Forward Work Planning process is to delete the Maintenance 

Intervention Strategy for a Treatment Length whenever a change is made to the 

Treatments in Years 1 to 3. 

End of Year Rollover affects all Years 1 through 3, so if there was a Treatment 

present in any one of those Years the MIS will be deleted. 

It is the responsibility of the Consultant to ensure that any missing Maintenance 

Intervention Strategies are replaced. Using the Forward Work Programme 

Planning Grid you should be able to find all the Treatment Lengths that are 

affected. 

 

MARG Priorities 

MARG values are calculated for Year 2 of the Forward Work Programme. 

Therefore, since Year 2 has become Year 1 after the Rollover, the values we have 

previously calculated no longer apply. To avoid confusion the MARG values are 

completely cleared for the database. 

 

Safety Intervention Strategies 

The End of Year Rollover does not alter Safety Intervention Strategies. However, 

it would be sensible to review them when the Consultant has downloaded a new 

copy of the database. 

 

Allowed Treatments 

Treatments are defined by the New Zealand Transport Agency (NZTA) as being 

applicable only for certain Years in the Forward Work Plan. 

End of Year Rollover can cause some Treatments to move from a Year where they 

are valid into a Year where they are not. 

Finding these Treatments by visually scanning through the Programme is not an 

easy task. Therefore, RAMM provides you with a report to assist. 
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The Out-of-Date FWP Treatments report can be accessed from RAMM Manager 

using the menu Reports > Forward Work > Programme Integrity > (select 

Out-of-date Treatments). 

It is the responsibility of Consultants to update the Forward Work Plan to replace 

any out-of-date Treatments with more appropriate alternatives. Therefore, it is 

recommended that you run this report as soon as you download a new copy of the 

Consultant database following End of Year Rollover. 

 

Primary Motivators 

All Reason codes for whom Primary Motivators have been defined must be 

associated with a Primary Motivator when used in Years 1 to 5. This means that 

any such Reason used in Year 6, to which a Primary Motivator has not been 

assigned, is now in error as it moves into Year 5. 

Like, Treatments this is a difficult thing to scan for visually and so RAMM 

provides you with a Missing Primary Motivators report. You can access this report 

in RAMM Manager from the menu Reports > Forward Work > Programme 

Integrity > (select Missing Primary Motivators). 

It is the responsibility of Consultants ensure that all Reasons that require a 

Primary Motivator have an appropriate one assigned. Therefore, it is 

recommended that you run this report as soon as you download a new copy of the 

Consultant database following End of Year Rollover. 

 

Inactive Treatments 

Inactive Treatments have no connection with End of Year Rollover and therefore 

should not be a cause for concern. However after performing an End of Year 

Rollover it would be advisable to check for Inactive Treatments still in the 

Programme. 

From time to time the New Zealand Transport Agency (NZTA) decides that a 

given Treatment is no longer applicable. Since historical references to the 

Treatment must be kept, the Inactive Treatment can not be removed from the 

system. 

However, the process of flagging a Treatment as Inactive does not force any 

changes to the Plan. 

Once you receive a new copy of the Consultant database following the End of Year 

Rollover it is recommended that you look for and replace any Treatments that are 

now inactive. RAMM provides a report to help you locate any of these cases. You 

can get to the report in RAMM Manager from the menu Reports > Forward Work 

> Programme Integrity > (select Inactive Treatments). 
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What Else Can I Do with RAMM Forward Work Planning? 

There are a number of other tasks that can be performed within the RAMM 

Forward Work Programme. They will not be things that you would do every day. 

These tasks are: 

• Combine All Programmes. 

• Unload RAMM Data for dTIMS CT. 

• Load dTIMS CT Analyses. 

• National Table Export. 

• National Table Import. 

 

Combine All Programmes 

Combine All Programmes is the process by which the Forward Work 

Programmes, from two or more databases, can be combined into the current 

database. One combined Current Programme is created from those in the source 

databases. 

Connect to the database that is to be the destination for the combined Forward 

Work Programmes and choose the databases that will be used to provide the 

source data. 

Note that this process will remove all Programmes in the destination database 

before generating the new combined Programme. 

This option is available only to the New Zealand Transport Agency (NZTA), 

using the RCA master databases and by logging in to the Entire Network Security 

Zone. You access this in RAMM Manager using the Projects > Forward Work > 

Combine All menu. 



 

1 6 8  F o r w a r d  W o r k  P r o g r a m m e  
 

 

 

Remember that the database that you are currently connected to, whose name 

appears in the window title, is going to be used as the destination for all the source 

databases. This means that anything that is currently recorded in this database will 

be deleted and replaced with the incoming information. 

Select your source databases from the list available on this window. The databases 

that you choose will only have information read from them and will not be altered 

or affected in any way. 

The Combine All Programmes process is intended to be run when connected to 

the RAMM8 database, which is a blank database specifically created for this 

purpose. 

 

dTIMS Analyses and Forward Work Planning 

dTIMS is a tool used to analyse Pavement data and make recommendations for 

the Forward Work Programme (FWP).  provides a method of extracting 

Treatment Length and other data from your Network in a format that can be 

imported into dTIMS. 
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Once you have completed your dTIMS Analyses you can extract the results of one 

or more of them to be returned to  as an Alternate Scenario. 

These dTIMS recommendations are available in  for reference and can be 

compared against the Current or other Programmes. Please note that dTIMS 

Treatment definitions are not the same as those used by .  

 

 

dTIMS and  have no formal links. They do not share the 

same database, so please be aware that if you make changes in one 

system they are not directly reflected in the other. 

 

 

dTIMS/dTIMS CT/dTIMS CT Express Unload 

In the RAMM main window, select the type of unload you wish to perform. All 

three unload selections are available from the dTIMS menu. 
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The selected dTIMS unload will launch the relevant process and unload the 

required data. 

 

The Path window shows the location of the unload file. You can change this 

location if necessary by typing it in or clicking the Browse button  to choose 

another location. 

Click the Unload All button next to the Path window and select the file type for 

your unload files. RAMM will create the unload files at the selected location. 

 

dTIMS CT Load 

Information from the dTIMS CT Analysis can be loaded into RAMM by 

following the menu path Projects > Forward Work > dTIMS CT Load menu in 

RAMM Manager. 

The information that RAMM will accept using this import option must have been 

extracted from the dTIMS CT database using the extract utility available from 

CJN Technologies Ltd. 

 

National Tables Export 

Data which is recorded in tables that are nationally maintained, by the New 

Zealand Transport Agency (NZTA) can be unloaded from the master database in 

RAMM Manager using the Projects > Forward Work > National Tables > Export 

menu. 
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Much of the national data differs for each of the Security Zones in your database. 

Therefore, you need to select the Security Zone for which you wish to extract 

national data and save that to its own file. Create and send to your Consultants, 

one file for each Security Zone. 

The nationally controlled data that will be extracted is as follows: 

• Maintenance Intervention Strategies. 

• Safety Intervention Strategies. 

• Treatments. 

• Treatment Groups. 

• Funding Groups. 

• Reasons. 

• Primary Motivators. 

• Reason/Primary Motivator Relationships. 

• MARG Factors. 

• MARG Weightings. 

• MARG Default Activities. 

• Note Types. 

Running the process will display a list as follows: 
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This is a list of all the nationally controlled tables that have had data extracted and 

stored in the file that you nominated. You can now send this file to your 

Consultant to be loaded into their database. 

 

National Tables Import 

You load the latest version of the nationally controlled data in RAMM Manager 

from the Projects > Forward Work > National Tables > Import menu. 
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You can import the data for only one Security Zone at a time. If you have two or 

more Security Zones in your database then you should have received one file for 

each of them. Clicking on the Import button displays the following: 

 

 

Once this is complete, your National tables will be up to date. 
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Maintenance treatments drawn from Year 2 of the Forward Work Programme into 

the Annual Plan may require further detailed consideration before commitment. 

Chapter 1 – Section 10 of the SHAMM discusses Project Ranking in terms of 

Pre-commitment Verification, Project Ranking Methodologies, and Specific 

Methodologies. 

Ranking methodologies are currently available for Area Wide Pavement Treatment 

and Resurfacing. 

In  Th is  Chap ter  
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1 7 6  F o r w a r d  W o r k  P r o g r a m m e  
 

Maintenance Allocation Review Group Calculations 

The methodologies used in the Maintenance Allocation Review Group (MARG) 

calculations are the Pavement Area Treatment Index (PATI) and the Resealing Index 

(RI). 

Detailed discussions of these methodologies can be found in the SHAMM manual. 

See Chapter 1 – Appendix G for a discussion of PATI calculations and Chapter 1 – 

Appendix H for the RI calculations. 

 

When Do You Need To Calculate MARG? 

In the Forward Work Programme process, MARG Weighting is only used after the 

following activities are completed: 

• Treatment Lengths altered, validated and problems corrected 

• Exceptions run to highlight problem areas 

• Treatment selection run to recommend treatments and report missing data 

• Forward Work Programme decided for each Treatment Length 

• optionally, the programme unloaded by consultants, loaded by the New Zealand 

Transport Agency (NZTA)Head Office and collated into a larger Network view. 

It is assumed at this point in the process, that any data problems underlying the 

Forward Work Programme or Treatment Lengths will have been reported in 

previous activities and have been rectified as far as possible. There is no 

requirement to report problems such as data being unavailable, or business rules 

compromised when calculating the MARG Weighting for a treatment. If problems 

are encountered that prevent the MARG Weighting being calculated, it is set to 

zero and you are warned of the Treatment Length and treatment that failed. 

The process to recalculate MARG Priorities is run by you whenever required. 

MARG priorities are not recalculated as part of the Treatment Length Summarise 

process.  

The calculation is always performed on current available data.  

 

Overriding the Calculated MARG Values 

The New Zealand Transport Agency (NZTA) has the ability to override the 

calculated MARG values. Both the calculated and override figures are kept in the 

system. When rerunning the MARG calculation at NZTA you can choose to clear 

the override values if you wish. Consultants do not have the ability to either enter 

override values or clear any that may be present in the database. 
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An additional priority indicator is available that is independent of the calculated or 

override MARG values. This priority, which is of the form of a 

High/Medium/Low flag can be set against a Treatment Length at any time. 

 

Who can use MARG? 

You can have three levels of access to the MARG facilities: 

• View - You can view MARG Weighting calculated for a treatment.  

• Run - You can clear MARG priorities and rerun the calculations. 

• Override - You can override the system-calculated MARG Weighting (NZTA only). 

 

Assigning MARG Indices to Treatments 

The definition of which Treatments are associated with the Reseal Pavement Area 

Treatment Index is achieved through the Treatment Group Definition. 

 

 

Each Treatment Group can be assigned to either the Reseal Index or PATI. 

Therefore, all Treatments that are members of that Group are then included in the 

calculation. Other Treatments that currently do not have a MARG score 

calculated for them can be added to the appropriate Treatment Group such  as 

Pavement or Surfacing (Reseal). You do this at the Treatment Group drop-down 

list on the Treatments window. 

 

MARG Factors and Weightings 

All the weightings, the parameters for the weightings and the adjustment factors 

are maintainable by you. However, the database administrator should be the only 

person to change these weightings. This is to ensure national uniformity when it 

comes to ranking projects for funding allocation. 
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Maintaining MARG Factors 

Access to the MARG Factors maintenance window is through RAMM Manager 

using the menu Projects > Forward Work > MARG > Factor. 

 

 

The MARG Index Factors have been defined by the New Zealand Transport 

Agency (NZTA) and preloaded into the database. It is not possible for either the  

NZTA or Consultants to add or remove these Factors. 

However, the value of the Weight, given to the Factor, can be modified at any time 

by either NZTA or Consultants from the Entire Network Security Zone. 

Consultants should note, however, that this information is not recorded by 

Security Zone and is not returned to NZTA. 

 

Maintaining MARG Weightings 

Access to the MARG Factors maintenance window is through RAMM Manager 

using the menu Projects > Forward Work > MARG > Weighting. 
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Once again the MARG Weighting Types have been defined by the New Zealand 

Transport Agency (NZTA) and loaded into the database. It is not possible for 

either NZTA or Consultants to add or remove Weighting Types. However, the 

Weightings that go to make up the Types can be added to, deleted, or modified. 

This is available to either NZTA or Consultants. 

Consultants should note, however, that this information is not recorded by 

Security Zone and is not returned to NZTA. 

 

Calculating A MARG Score 

Check that there is a value in the Upper Pavement Layer Moisture Sensitivity box 

on the Pavement tab in the Treatment Length detail view. A MARG value can not 

be calculated without this.  

The default value is Not A Problem. The Consultant should select their own 

value for this field. To add or change a value, click the Maintain button on the 

Treatment Length table in RAMM. All other fields should be populated because 

most of the data is taken from the Treatment Length summary table, which is 

updated when Treatment Length Resummarise is run. 

Click Calculate on the Year 2 MARG Weightings tab of the Treatment Length 

detail view or of the Forward Work Programme window in RAMM, or in RAMM 

Manager from the menu Processes > Treatment Lengths > MARG Calculation. 

Select either the current Treatment Length or all Treatment Lengths. This may 

take some time for a network. Decide whether you want to erase user-entered 

(override) values and priorities. These options are available only to the New 

Zealand Transport Agency (NZTA) users. 

Click Calculate. After calculation has finished, press F5 to refresh the window and 

view the calculated MARG values. 

It is also possible to calculate the MARG score for all or an individual Treatment 

Length by accessing the Year 2 MARG Weightings tab on either the Treatment 

Length Detail window or the Forward Work Planning window. 

 

User Override and Priorities 

If the New Zealand Transport Agency (NZTA) thinks that the calculated score is 

not right, then a score that is more representative of the Treatment Length can be 

entered. A priority can also be attached if this is appropriate. 
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These user-entered values can only be entered and changed by NZTA and can not 

be erased by the Consultant. They are not erased when MARG is recalculated 

unless specified and in the reporting the override value is used for ranking, not the 

calculated value. 

To enter values, simply click on the box next to the calculated MARG score and 

type the number or select from the drop-down list for the priority. 

You can access the MARG data for a Treatment Length from the Year 2 MARG 

Weightings tab on the Treatment Length Detail window. 

 

 

Alternatively, you can also get at the same information from the Year 2 MARG 

Weightings tab on the Forward Work Planning window. 

 

 

 

Reporting MARG Scores 

There are two MARG Score reports available in RAMM Manager: 
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1 MARG Calculation Error 

This details calculation errors in the MARG process. This is when the word Failed 

appears in the MARG value field, or the value in the field is zero.  

2 MARG Treatment Detail 

This lists those Treatment Lengths with a MARG value, from highest score (highest 

priority) to lowest score (lowest priority) by Programme, Region, Network 

Management Area and Treatment Group.  

These are accessed from Reports > Forward Work > MARG Calculation Error 

and Reports > Forward Work > MARG Treatment Detail. 
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The following is a checklist of database housekeeping functions to be carried out 

periodically. It must not be regarded as complete. Consider it a dynamic list that 

will be added to based on operational experience, user feedback and requests for 

assistance. 

In  Th is  Chap ter  

Tables ........................................................................................ 184 

Functions ................................................................................... 184 
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Tables 

Cost Sets - the treatment Cost Sets should be reviewed at least annually checking: 

• the appropriateness of the split of Cost Sets. Do they still fairly represent the areas 

where costs change? 

• the costs allocated to each treatment within the Cost Set. 

 

Functions 

Summarise - This process is described within the software documentation. It 

summarises the data held against Treatment Lengths. It checks the integrity of the 

consistency of the Treatment Lengths. For instance, it checks whether they are 

contiguous and whether they cover the full length of road names. 

 



 

  

C H A P T E R  1 7  

The information in your  Database is valuable. 

You will want to control who may access your database information and exactly 

what they are permitted to do with it. 

 enables you manage user access and permissions by a combination of 

global security parameters, individual Security Profiles, Security Roles and 

Security Zones. 

In  Th is  Chap ter  

Understanding RAMM Security .............................................. 186 

Global Security Switch .............................................................. 186 

Default User Security Profile ................................................... 187 

Security Roles ............................................................................ 187 

Security Zones ........................................................................... 187 

Managing RAMM Security ....................................................... 189 

Adding a Security Zone ............................................................. 190 

Adding a Security Role .............................................................. 193 

Adding a User ............................................................................ 198 

Setting Custom Security Permissions ...................................... 206 

Examples of Customised Security Permissions ........................ 211 
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Understanding RAMM Security 

You will find it easier to work with  Security if you first understand its 

underlying concepts and assumptions. You should read this section before starting 

to work with  Security.  

 

History of Security in RAMM 

 has always offered user Security. At a basic level, Security has been 

implemented on a per user basis using a range of switches covering different 

aspects of the data and  functions. Each of these switches, such as the one 

used to control access to the Drainage Inventory, has a hierarchical series of  

preset levels defined. For instance, this allows you to give a user view-only access 

so they can see but not touch, or to give them view and update access. The latter 

case would allow a user to make changes to the Drainage Inventory. 

In fact,  is much more sophisticated than this example suggests. There are 

also controls in place for managing Lookups associated with the Asset, for example 

Drainage Type. In addition, you can prevent someone from importing data using 

File > Import or control what they can do using . 

 

Global Security Switch 

The Global Security switch is an efficient method of granting preset levels of 

database access. 

 Security uses a Global Switch. This sits on top of the individual switches 

and allows you to set a specific range of values across all the individual switches in 

one go. This switch has five settings: 

• No Access 

• View Only 

• Contractor 

• Full Control 

• Custom Settings. 
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If you use this Global Setting to set a user to View Only it means that all the 

individual permission switches for that user are set to View Only. Setting No Access 

has the effect of denying a user any access at all to the  Database. Contractor 

enables the use of preset  Roles. Full Control gives the user just 

that - permission to access anything and to run any process. Using Custom Settings 

gives you access to the individual permission switches so you can personally tailor 

the Permissions for a user. 

 

Default User Security Profile 

Default Permissions make it simple for you to deal quickly with most users. You 

can create a default set of Permissions, usually for View Only, which will be used by 

anyone connecting to your  Database if their Permissions are not explicitly 

defined. 

 

Security Roles 

Although having a Default Permissions set can make it easy to deal with a large 

group of casual users, it does not give you a way of handling the situation when 

you have a large number of users but they are divided into a relatively small 

number of Roles within the  Database. In this case it would be useful to be 

able to set up a limited number of Permissions and assign users to one or other as 

appropriate. 

Therefore, the concept of Security Roles was introduced. You can treat a Security 

Role as if it were a user and set permissions, either Global or Custom, as you 

would for a person. When you add a user to the database you can choose a Security 

Role for that person to use rather than set up individual Permissions. 

There are two advantages to doing this. Firstly, it is quicker to add a person to the 

database and to give them the appropriate Permissions. Secondly, you can change 

the Permissions for a whole group of people in one go by changing the 

Permissions associated with the Role. 

 

Security Zones 

Security Zones are used to manage access to parts of the Road Network in the 

 Database. 
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When the NOMAD Forward Work Programme was designed and implemented 

in  it was necessary to find a way to divide the Road Network into Network 

Management Areas. The method chosen to do this was to use the Carriageway 

Area. In a State Highway Database, this works well as there can be few 

Carriageway Areas defined covering relatively large geographical areas. However, 

in Local Authority Databases, the Carriageway Area was most often used to define 

Wards. Whilst the State Highway could easily be managed by breaking it down this 

way, the Local Authority would not typically want to divide the Network up this 

way for Maintenance Management. 

However, within , it would be possible to have two 

Maintenance Contractors working within a Local Authority Network each with 

responsibility for part of the Network. Once again these Network portions are 

unlikely to match the Ward boundaries. 

Therefore, something more flexible was required that allowed a Network to be 

divided into portions by any criteria you require. 

This tool is the Security Zone. 

A Collection of Roads 

At its basic level, a Security Zone is a portion of the Network defined as a 

collection of Roads. You can choose to select all the Roads in a geographical area 

and call them a Security Zone. Alternatively, you could pick a group of Roads with 

a common characteristic such as Unsealed, wherever they may occur within the 

Network and call it another Security Zone. 

When Security Zones were introduced, some standard definitions were 

automatically put in to the  Database. In the case of a Local Authority 

Database, one Security Zone called Entire Network, was automatically placed into 

the database. In the case of a State Highway Database, in addition to the Entire 

Network, Security Zones were created for each  Region, Network 

Management Area and for each Contract Area within the NMA. 

 

Grant and Revoke Permissions 

When you make changes to user Permissions,  tells the Informix database 

to align its internal permissions (Connect, Resource, DBA) accordingly. This 

happens automatically when you close the Staff Permissions screen after making 

changes. If you want to manually grant or revoke permissions, you go to the menu 

at the top of the Staff Permissions screen and choose File > Grant/Revoke. 

This special control commits the changes you make to a Permissions record to a 

database, allowing you to continue working with the Staff Permissions screen. 
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Managing RAMM Security 

Managing  user security involves adding and changing Security Zones 

followed by adding or modifying Security Roles and user permissions to reflect 

the changing needs of the people who use your  Database. 

Managing  security involves: 

• adding and configuring Security Zones 

• adding and configuring Security Roles 

• adding users to the system. 

• setting up Security Permissions for those users by selecting a Role for them, or 

manually configuring user tasks. 

You can view your own Security Permissions. However, you must have specific 

permissions to be able to: 

• view the security details of other users 

• modify the security details of yourself and other users 

• create new users 

• view, modify or create Security Zones 

• view, modify or create Security Roles. 

 

Viewing Security Zone Details 

All your users will need to be associated with one or more Security Zones. You 

will need to spend some time setting this up initially. 

All  Databases will have at least one Security Zone called the Entire Network.  

This Security Zone has some special characteristics within . Firstly, it will 

always contain every Road within the Database. This occurs automatically. So you 

do not have to worry about losing access to new Roads. There are also some 

actions which are available to you only of you are logged in to the Entire Network. 

 

 

 

You will need to have the correct Security Permissions before you 

can perform this procedure. See your Systems Administrator for 

assistance if required. 

►  To  V iew  Secur i ty  Zone  De ta i l s  

1 Launch . 

2 Follow the menu path Maintenance > Security Zones to open the Security Zones screen. 
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3 Go to the list of Security Zones on the left hand side of the screen and select the one 

whose details you want to view. 

4 You will see the details of the selected Security Zone on the right hand side of the 

screen. This includes a listing of all the Roads which have been selected. 

 

 

 

Adding a Security Zone 

When you need to restrict the access of one or more users to a portion of your 

Network, you will need to create a Security Zone for them to use. 

 

 

 

You will need to have the correct Security Permissions before you 

can perform this procedure. See your Systems Administrator for 

assistance if required. 

►  To  Add  a  Secur i ty  Zon e  

1 Launch . 

2 Follow the menu path Maintenance > Security Zones to open the Security Zones screen. 

3 Press Add Security Zone  or CTRL+N. 
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4 Add the details for the Security Zone: 

• Description 

The name of the Security Zone 

• Parent Security Zone 

This is the name of the Security Zone which will contain the new one. Each 

Security Zone, except for the Entire Network, requires a parent. You will be 

restricted to choosing Roads from the Parent for your Security Zone. The default 

Parent Security Zone will be the one into which you are logged in. 

• Starting Cost Set 

You have the option to restrict the Cost Sets associated with your Security Zone to 

a defined range of numbers. The Starting Cost Set is the lowest number your 

Cost Sets will be able to take. This number must fall within the range available to 

the Parent Security Zone. 

• Ending Cost Set 

You have the option to restrict the Cost Sets associated with your Security Zone to 

a defined range of numbers. The Ending Cost Set is the highest number your 

Cost Sets will be able to take. This number must fall within the range available to 

the Parent Security Zone. 
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• Explanation 

You have the option of associating free-format notes with this Security Zone. 

Notes which are added at the time of creation or editing can be very useful at a 

later date. Notes can help if you have forgotten why you did something or if 

another user needs to understand your reasoning and purpose. 

5 Choose the Roads which are to be associated with the Security Zone. You can add and 

remove individual Roads from the list by using the Insert and Delete buttons. When 

you press the Insert button a new record will be added to the list of Roads. You select 

the Road you want to add from the drop-down list. 

6 Although you may want to add Roads individually, it is very likely that you will want to 

select multiple Roads based on one or more selected characteristics. You can do this by 

pressing on the Filter button . A standard Filter Dialog will open and you can choose 

to filter by anything from the Road Names, Carriageway Sections or Treatment 

Lengths. 

 

The Roads selected by the Filter will be added to the list of Roads for the Security 

Zone. 

 

 

You should consider the Filter characteristics which you select 

very carefully before you apply them. You may not achieve the 

results which you expect. The Security Zone is a collection of 

Roads. So if, for example, you set up a Filter for Urban 

Carriageway Sections and accept all the Roads returned, you may 

see Rural Carriageway Sections when you log in to . This 

occurs when you have both Urban and Rural Carriageway 

Sections on the same Road. 
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Deleting a Security Zone 

You can delete a Security Zone only if it has not been used in the Permissions of 

any user. 

 

 

 

You will need to have the correct Security Permissions before you 

can perform this procedure. See your Systems Administrator for 

assistance if required. 

►  To  De le te  a  Secur i t y  Zone  

1 Launch . 

2 Follow the menu path Maintenance > Security Zones to open the Security Zones screen. 

3 Select the Security Zone which you want to delete. 

4 Press Delete Record . 

The Security Zone is deleted. 

 

Adding a Security Role 

Adding a Security Role is similar to adding a new user. You name the Security 

Role and define a Permissions Profile to go with it. The only difference is that the 

Security Role itself is independent of Security Zones. 

 

 

 

You will need to have the correct Security Permissions before you 

can perform this procedure. See your Systems Administrator for 

assistance if required. 

►  To  Add  a  Secur i ty  Ro le  

1 Launch  and follow the menu path Maintenance > Staff to open the 

Staff Permissions screen. 

2 Press Add New Record  and select Add New Security Role from the drop-down list 

which appears. 

3 Type the name for the Security Role in the Security Role field and any notes in the 

Explanation field, if necessary. 
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4 Beneath the new Security Role you will see the RAMM Permissions Profile. If you can 

not see them then press the adjacent Plus button  and the tree will open revealing the 

dated Profile Records. The default Profile is the Global View Only. 

5 Define the Permissions Profile for the Security Role by selecting a Global setting: 

• No Access 

• View Only 

• Contractor 

• Full Control 

• Custom. See Setting Custom Security Permissions (on page 206). 

6 Save your changes by pressing Save Record  or CTRL+S. A new Profile record with 

the data entry date is created beneath the name of the Security Role. 

 

 

 

Your changes are effective immediately in  but 

corresponding Informix Permissions are automatically granted or 

revoked when you close the Staff Permissions screen. See Grant and 

Revoke Permissions (on page 188). 
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Changing Security Role Settings 

When there is a change in the way that users of a Security Role access , you 

need to update the Security Role Profile. 

 

 

 

You will need to have the correct Security Permissions before you 

can perform this procedure. See your Systems Administrator for 

assistance if required. 

►  To  Change  Secur i ty  Ro le  Se t t i ngs  

1 Launch . 

2 Follow the menu path Maintenance > Staff to open the Staff Permissions screen. 

3 Select the Security Role which you want to change from the list on the left hand side of 

the screen. 

 

 

4 Beneath the Security Role you will see the RAMM Permissions Profile. If you can not see 

them then press the adjacent Plus button  and the tree will open revealing the dated 

Profile Records. 
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You can not change historical Profile records. The Security Role 

Details are on the right hand side of the screen. 

 

5 Change the name or explanation for the Security Role. 

6 The current standard Security Profile will be highlighted in blue. Choose another of the 

standard Security Profiles from those on the right hand side of the screen or set Custom 

Permissions. See Setting Custom Security Permissions (on page 206). 

7 Save your changes by pressing Save Record  or CTRL+S. A new Profile record with 

the data entry date is created beneath the name of the Security Role. 

 

 

 

 

Your changes are effective immediately in  but 

corresponding Informix Permissions are automatically granted or 

revoked when you close the Staff Permissions screen. See Grant and 

Revoke Permissions (on page 188). 

 
 

Viewing User Security Settings 

Once you have set up Security Zones it is possible to assign and view Permissions 

for a user. All users can view their own Security settings but you will need the 

correct Permissions to view the Permissions of another user. 

 

 

 

You will need to have the correct Security Permissions before you 

can perform this procedure. See your Systems Administrator for 

assistance if required. 

►  To  V iew  User  Secur i ty  Se t t i ngs  

1 Launch . 

2 Follow the menu path Maintenance > Staff to open the Staff Permissions screen. 

3 Select, from the list of users on the left hand side of the screen, the user whose 

Permission details you wish to view. 
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4 You will notice one or more Security Zones beneath the name of the user. If you can 

not see them then press the adjacent Plus button  and the tree will open revealing the 

Security Zones. 

 

 

5 Within each Security Zone you will see one or more dated Profile Records. If you can 

not see them then press the adjacent Plus button  and the tree will open revealing the 

dated Profile Records. The top record contains the current settings for the user. Select 

the name of the person whose details you wish to see on the right hand side of the 

screen. 

6 If the person has been assigned a Security Role, this will be displayed in the Security 

Role field at the top of the screen. If this person has customised Permissions, they are 

displayed in the lower section of the screen. Select them to view the Permission details. 
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7 To find out more about a Permission, hover the mouse pointer over it and a tool tip 

will appear with further information. 

 

 

 

Adding a User 

When someone needs access to your  Database, you will need to create a 

Security record for them. 

 

 

 

You will need to have the correct Security Permissions before you 

can perform this procedure. See your Systems Administrator for 

assistance if required. 
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►  To  Add  a  User  

1 Launch . 

2 Follow the menu path Maintenance > Staff to open the Staff Permissions screen. 

3 Press Add New Record  and select Add New User from the drop-down list which 

appears. The Select User to Add screen opens. 

4 Type the name for the user in the Name field. 

 

 

By default you are expected to add a named person at this dialog, so Add New User is 

highlighted. You can choose to add a default Permission for all users in which case you 

select All Users. 

If you are on the  Hosting Service, then, when you start typing, you will see a 

list of all the people who are users of the Hosting service whose names match the initial 

letters you have typed. As you type more of the name of the person to whom you want 

to give access, the list will progressively grow smaller as  performs a match 

against the name you type. When you see the name you want, select it. If you have 

 installed locally, you will need to type the name of the person in full. 

5 Press OK to open the Add Staff Permissions dialog. 
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6 Select the Security Zone for the person to access from the Security Zone drop-down 

list and press OK. 

7 The new user record initially appears below the list of users. On the right hand side of 

the screen you will see the details of the new person. 

 

 

The name of the person will be filled in and in addition, if you are on the Hosting 

Service, their other known details will also default. 

8 You should now type in the following user details if the fields are blank: 

• Name 

The full name of the person should already be complete. 

• Login Name 

The name the person uses to log in to your  database. This must be 

completed accurately for your Security to work properly. An incorrectly typed 

login name may result in the person having no access to the Database.  
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• Organisation 

The name of the organisation to which the person belongs. Once you have 

completed this field the person will be listed under the name of the organisation 

on the left had side of the screen. You must complete this mandatory field. 

• Phone 

The land line telephone number of the person 

• Mobile 

The mobile phone number of the person 

• Fax 

The fax number of the person 

• SMS Mobile 

The mobile phone number of the person on which they receive SMS text 

messages. 

• [Notes]. Free-format notes about this user. 

9 Press the Plus button  adjacent to the name of the person on the left hand side of the 

screen. When the tree opens, select the RAMM Permissions Record from beneath the 

Security Zone. 
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The default Security Profile when you add a new person is View Only. This gives them 

Permission to view all the information in your Database. You can leave the person with 

this Permission or choose one of the other Global Permission Settings. 

The other settings are: 

• No Access 

The person will not be able to access your  Database at all. This person 

will be rejected when they try to log in. 

• Contractor 

The person does not need access to  or to . They are a 

Contract Manager using Pocket  and . 

• Full Control 

The person has full access to your  Database to manage all the inventory, 

condition surveys and to run any process. 

• Custom 

The person has a set of individual Permissions which do not correspond to one of 

the Global settings. See Setting Custom Security Permissions (on page 206). 

As an alternative you can select one of the predefined Security Roles from the Security 

Role drop-down list. 

10 Save your changes by pressing Save Record  or CTRL+S. A new Profile record with 

the data entry date is created beneath the Security Role name. 
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Your changes are effective immediately in  but 

corresponding Informix Permissions are automatically granted or 

revoked when you close the Staff Permissions screen. See Grant and 

Revoke Permissions (on page 188). 

 
 

Changing User Security Settings 

When there is a change in how a person uses  you will need to update their 

security settings. This could be because they now have a different role or extra 

responsibilities. 

 

 

 

You will need to have the correct Security Permissions before you 

can perform this procedure. See your Systems Administrator for 

assistance if required. 

►  To  Change  User  Secur i ty  Se t t i ngs  

1 Launch . 

2 Follow the menu path Maintenance > Staff to open the Staff Permissions screen. 

3 Select the person whose details you want to change from the list on the left hand side 

of the screen. 

4 Beneath the name of the person you will see one or more Security Zone Profile records. 

If you can not see them then press the adjacent Plus button  and the tree will open 

revealing the dated Profile Records. 
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If you choose to display the expired permissions for the person by 

following the menu path Options > Show Expired Permissions you will 

see any Security Permissions for the person which are no longer 

valid. You can not change historical Profile records. 

 

5 Add or change the Security Role details for the person. 

• Name 

The full name of the person should already be complete. 

• Login Name 

The name the person uses to log in to your  database. This must be 

completed accurately for your security to work properly. An incorrectly typed 

login name may result in the person having no access to the Database.  

• Organisation 

The name of the organisation to which the person belongs. Once you have 

completed this field the person will be listed under the name of the organisation 

on the left had side of the screen. You must complete this mandatory field. 

• Phone 

The land line telephone number of the person 

• Mobile 

The mobile phone number of the person 

• Fax 

The fax number of the person 
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• SMS Mobile 

The mobile phone number of the person on which they receive SMS text 

messages. 

• [Notes]. Free-format notes about this user. 

6 Select the Profile Record of the person. The details will appear on the right hand side of 

the screen. 

 

 

7 Either: 

• Select a standard Security Profile from the buttons across the top of the right hand 

side of the screen. The current Profile is highlighted in blue. Or 

• Set Custom Permissions. See Setting Custom Security Permissions (on page 206). 

Or 

• Select one of the predefined Security Roles from the Security Role drop-down list 

at the top of the right hand side of the screen. 

 

 

You can not change the Profile of a Security Role without looking at 

the details of the person. See Changing Security Role Settings (on 

page 195). 

 

8 Save your changes by pressing Save Record  CTRL+S.  

A new Profile record with the data entry date is created beneath the name of the 

Security Role. 
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Your changes are effective immediately in  but 

corresponding Informix Permissions are automatically granted or 

revoked when you close the Staff Permissions screen. See Grant and 

Revoke Permissions (on page 188). 

 
 

Setting Custom Security Permissions 

When you are adding or changing user Security Settings, you may need to 

customise their access to parts of  within a Security Zone, particularly if the 

person needs to run processes. 

 

 

 

You will need to have the correct Security Permissions before you 

can perform this procedure. See your Systems Administrator for 

assistance if required. 

►  To  Se t  Cus tom Secur i t y  Per miss ions  

1 Launch  and follow the menu path Maintenance > Staff to open the 

Staff Permissions screen. 

2 Select the person or Role whose details you want to change from the list on the left 

side of the screen. 

3 Beneath the name of the person you will see one or more Security Zones. If you can 

not see them then press the adjacent Plus button  and the tree will open revealing 

them. Security Roles do not apply to specific Security Zones. So you will not see 

Security Zones underneath a Security Role. 

4 Beneath the Security Zones, or beneath the Security Roles of the person you will see 

one or more Security Zone dated Profile records. If you can not see them then press the 

adjacent Plus button  and the tree will open revealing the dated Profile records. Select 

the record you wish to change and the details of the current Permission settings will 

display on the right side of the screen. 

 

 

If you choose to display the expired Permissions for the person by 

following the menu path Options > Show Expired Permissions you will 

see any Security Permissions for the person which are no longer valid. 

You can not change historical Profile records. 
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5 If the user or Role already has Custom Permissions, the Custom Global Setting switch 

will be highlighted in blue and the details will be displayed. 

If the user or Role does not already have Custom Permissions, press the Custom Global 

Setting button . 

6 You will notice that Permissions are grouped together into related items shown in the 

tree in the middle section of the screen. 

 

 

• Some groups have further Permission Groups listed under their name. If you can 

not see them then press the adjacent Plus button  and the tree will open. 

• When you select a group, the Permissions for each task in that group are listed in 

the Custom Permissions panel on the right hand side of the screen. 

• For information about a particular task, point to it and a Tool Tip appears: 

 

 

• To quickly change permissions for all the tasks in the selected group, press on one 

of the standard Profile icons. There are standard Profiles for No Access , 

View Only  or Full Control . The current Profile is 

highlighted in blue and you can see its icon to the left of the Permissions Group. 

• To customise Permissions for specific tasks, go to the Standard Profiles panel and 

press . You can then select and clear Permissions one by one. A selected 

Permission signifies that the user or Role has Permission for that task. For 

examples see Examples of Customised Security Permissions (on page 211). 

7   will warn you if you need other permissions in addition to the ones which 

you have selected. 
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8 Save your changes by pressing Save Record  CTRL+S. A new Profile record will be 

created for the user in the Security Zone or for the Security Role. 

 

Removing Custom Security Permissions 

When a user no longer needs Custom Permissions, you can revert their settings to 

one of the Global Definitions or to a Security Role. 

 

 

 

You will need to have the correct Security Permissions before you 

can perform this procedure. See your Systems Administrator for 

assistance if required. 

►  To  Remove  Cus to m Permiss ions  f ro m a  User  

1 Launch  and follow the menu path Maintenance > Staff to open the 

Staff Permissions screen. 

2 Select the person, from whom you wish to remove Custom Permissions, from the list 

on the left hand side of the screen. 

3 Beneath the name of the person you will see one or more Security Zones. If you can 

not see them then press the adjacent Plus button  and the tree will open revealing 

them. 

4 Beneath the Security Zones of the person you will see one or more dated Profile 

records. If you can not see them then press the adjacent Plus button  and the tree will 

open revealing the dated Profile records. The most recent Profile will be at the top of the 

list. When you select the record which you wish to change, the details of the current 

Permission settings will be displayed on the right hand side of the screen. 

5 Remove the Custom Permissions from this user by performing one of the following 

actions: 

• Define the Permissions Profile for the Security Role by selecting one of the Global 

settings: 

• No Access 

• View Only 

• Contractor 

• Full Control or 

• Select one of the predefined Security Roles from the Security Role drop-down list 

at the top of the right hand side of the screen or 

• From the menu at the top of the Staff Permissions screen, follow the menu path 

Edit > Use Default. This can also be done from the tool bar at the top of the Staff 

Permissions screen by pressing the Use the All Users Permissions   button. 
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Using the Alternative View 

When you want to see which users have which Permissions you can use the 

Alternative View of the Security Profiles. You can also use this screen to manage 

Profiles for individual users if you prefer. 

 

 

 

You will need to have the correct Security Permissions before you 

can perform this procedure. See your Systems Administrator for 

assistance if required. 

►  To  Change  User  o r  Secur i ty  Ro le  Permiss ion s  

1 Launch . 

2 Follow the menu path Maintenance > Staff to open the Staff Permissions screen. 

3 Press Alternate View  to open the Select Security Zone and Contract dialog. 

 

 

4 The default value at the Security Zone drop-down list will be Entire Network. Select a 

different Security Zone from the Security Zone drop-down list if required. 

5 Select, from the Contract drop-down list the Maintenance Contract for which you wish 

to view the Security Profile if appropriate. 

6 Press OK to open the Staff Permissions screen in its Alternate View. 
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7 Select one of the Permissions Groups from the (unnamed) Permissions Groups 

drop-down list at the upper left hand side of the screen. The available options will be 

listed below. A list of Users will be displayed in the panel on the right hand side of the 

screen. 

8 You can see from the list of users displayed in the panel on the right hand side of the 

screen, whether or not each user has the selected Permission in their current Security 

Profile. If you wish to add the selected Permission to a person or to a Security Role 

which does not have it, select the check box adjacent to the name of the person or 

Security Role. 

9 Save your changes by pressing Save Record  or CTRL+S. A new Profile record with 

the data entry date will be created for each of the updated people or Security Roles. 

 

 

Your changes are effective immediately in  but 

corresponding Informix Permissions are automatically granted or 

revoked when you close the Staff Permissions screen. See Grant and 

Revoke Permissions (on page 188). 
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Examples of Customised Security Permissions 

 allows you to be very flexible about which combinations of Permissions 

you assign to each user. See Setting Custom Security Permissions (on page 206).  

Please view the following examples: 

• Roughness Surveyor (on page 211) 

• Data Entry Operator (on page 212) 

• Bridge Inspector (on page 211) 

• Asset Valuer (on page 213). 

 

Roughness Surveyor 

This user can view Carriageway and Road Name data for this Security Zone, so 

that they can export the information before doing a Roughness Survey. They also 

have Full Access to the Roughness Survey tables. 

 

 

 

Bridge Inspector 

This user can create and enter Bridge Assessment data, but has no other access. 
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Data Entry Operator 

This user can enter data into all Asset and Condition tables, but cannot change 

Carriageway data. The user has no access to Asset Valuation or Assessment data. 
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Asset Valuer 

In addition to Permission for Asset Valuation, this user can maintain asset data for 

the Entire Network, but can not insert or delete assets. The user has View Only access 

for everything else. 

 

 

 





 

  

Database 

This is a structured collection of data 

that is stored in a computer so that 

an application can consult it to 

answer queries. In , this is a 

particular Road Network. It is 

possible that you will use more than 

one  database, especially if 

you work with more than one Road 

Controlling Authority. 

Detail Screen 

Detail screens in  are used for 

working with Road Inventory, 

Condition and other items one at a 

time. You use them to view and 

maintain details for one item only at 

a time. 

dTIMS 

Deighton Total Infrastructure 

Management System (dTIMS) is a 

software tool used to model 

Pavement Deterioration.  

provides a method of extracting 

Treatment Length, Maintenance 

Cost and related data from the Road 

Network in a format that can be 

imported into dTIMS. 

Filter (Database Filter, Grid Filter) 

Filters are the screens which you use 

to sort the data in Detail or Grid 

screens according to selected criteria. 

You use these to streamline the 

information you see in  such 

as in the Roads list panel.  

Grid Screen 

The Grid screen in  is a 

visual report writer. You use Grid 

screens to work with multiple Road 

Inventory, Condition and other 

items. You adjust the Grid Layout so 

that is looks right and it suits your 

purposes.  You can then view, 

export or print the displayed details. 

Hosting 

The ROMAN II Hosting Service is a 

service run by ROMAN II. It enables 

you to run  across the 

Internet. It hosts your database and 

the software on a server at a 

centralised location. You use your 

standard internet browser to access 

the software and work with your 

data, so you do not need any 

specialised software. It is very secure. 

LTNZ 

Land Transport New Zealand 

(LTNZ) was a Crown entity formed 

to promote land transport 

sustainability and safety. It allocated 

government funding for land 

transport. Its functions have now 

been taken over by the NZTA. 

MARG 

The Maintenance Allocation Review 

Group (MARG) is part of the New 

Zealand Transport Agency (NZTA). 

The methodologies used in the 

Maintenance Allocation Review 

Glossary 
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Group (MARG) calculations are the 

Pavement Area Treatment Index 

(PATI) and the Resealing Index 

(RI). 

MIS 

The Maintenance Intervention 

Strategy (MIS) is a detailed 

statement of the maintenance 

activities that will be carried out 

within the Treatment Lengths 

identified in the Forward Work 

Programme (FWP). 

It is prepared and reviewed in 

accordance with the New Zealand 

Transport Agency (NZTA) 

SHAMM. Definitions are 

maintained nationally by NZTA. 

Network 

A Network is a collection of Roads 

managed by a particular Road 

Controlling Authority (RCA). Each 

 database usually contains all 

the information for one Network. 

NMA 

A Network Management Area 

(NMA) is the section of the Roading 

Network for which a Consultant is 

responsible. NMAs are associated 

with MIS codes. 

NOMAD 

The National Optimisation of 

Maintenance Allocation by Decade 

(NOMAD) is the software 

component providing Pavement 

maintenance and treatment 

information at a project level for up 

to 20 years on behalf of the NZTA. 

It is also known as  Forward 

Work Programme and is interlinked 

with dTIMS, the decision tool for 

future works and the Annual Plan 

process. 

Null 

This means blank or having no 

value. Some  fields must have 

a value. These fields are highlighted 

with a coloured background. 

NZTA 

The New Zealand Transport 

Agency (NZTA) is the Crown 

Entity responsible for State 

Highways. These are the strategic 

Roads and motorways that are about 

12% (10,894 km) of all New 

Zealand Roads, but account for 

about half of the 36 billion vehicle 

kilometres travelled every year. It 

promotes land transport 

sustainability and safety and allocates 

government funding for land 

transport. 

RAMM 

Road Assessment and Maintenance 

Management ( ) is software 

developed and supported by RAMM 

Software Limited. This software is used 

by Road Controlling Authorities 

(RCAs) to manage Road Inventory 

Assets and Condition for their 

Network. 

RCA 

A Road Controlling Authority 

(RCA) is the organisation 
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responsible for a particular Road 

Network. An example of an RCA 

could be the New Zealand 

Transport Agency (NZTA) or a 

TLA (Territorial Local Authority). 

Record 

This is a collection of information 

about a single object. In  it is 

a grouping of all the details about a 

particular item such as a Berm or 

Street Light. You maintain single 

record details in a Detail screen. 

RMCE 

Routine Maintenance Cost 

Estimation (RMCE) curves provide 

the basis of cost estimation for 

Maintenance Intervention Strategies 

(MIS). 

Road Asset 

A Road Asset is a detail about a 

particular aspect of a Road. It could 

be the Pavement layers, Condition 

or other aspect. 

SHAMM 

The New Zealand Transport 

Agency (NZTA) State Highway 

Asset Management Manual. It is also 

known by its code SM020 and is 

available off the internet at SHAMM 

(http://www.transit.govt.nz/technical

/view_manual.jsp?content_type=ma

nual&=edit&primary_key=18&acti

on=edit). 

SIS 

The Safety Intervention Strategy 

(SIS) is a plan developed to ensure 

safety for each network maintenance 

management contract. It is prepared 

and reviewed in accordance with the 

New Zealand Transport Agency 

(NZTA) SHAMM.  

Table 

This is a container in the  

database that holds all the records 

about an aspect of all Roads in the 

database. This could be their Berm 

or Shoulder details for example. 

Each table holds all the information 

about only one aspect of all the 

Roads. 

TNZ 

Transit New Zealand (TNZ) was 

the Crown Entity responsible for 

State Highways. Its functions have 

now been taken over by the NZTA. 

TSA 

The Treatment Selection Algorithm 

(TSA) is the formula used to 

calculate optimal Forward Work. 

 

http://www.transit.govt.nz/technical/view_manual.jsp?content_type=manual&=edit&primary_key=18&action=edit
http://www.transit.govt.nz/technical/view_manual.jsp?content_type=manual&=edit&primary_key=18&action=edit
http://www.transit.govt.nz/technical/view_manual.jsp?content_type=manual&=edit&primary_key=18&action=edit
http://www.transit.govt.nz/technical/view_manual.jsp?content_type=manual&=edit&primary_key=18&action=edit
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